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1 Product basics

● Product features

● Product views

● Power on and off

● Use the control panel

● Quiet Mode
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Product features
PageWide Pro 552dw 

D3Q17A, D3Q17B, D3Q17C, D3Q17D

Tray capacity (75 GSM or 20–lb Bond paper)

● Tray 1: 50 sheets

● Tray 2: 500 sheets

● Optional Tray 3: 500 sheets

● Optional Tray 4: 500 sheets

● Standard output bin: 300 sheets

● Automatic Document Feeder (ADF): 50 
sheets

Print

● Simplex speeds up to 50 pages per minute 
(ppm) for both color and black with 
Professional quality

● Duplex speeds up to 21 ppm for both color 
and black with Professional quality

● Up to 70 ppm in General Office mode

● Walkup Plug-and-Print USB Device port

● Walkup printing of MS Office documents

Connectivity

● 802.3 LAN (10/100) Ethernet port

● Host USB Type A and Type B ports (back)

● USB 2.0 Device port (front)

Wireless

● Embedded wireless capability

● 802.11n 5GHz dual band support

● HP ePrint—send documents to the product 
email address for printing

● HP Wireless Direct support

● NFC-enabled (Near Field Communications); 
walkup printing from smart phones and 
tablets
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Environmental features

Feature Environmental benefit

Duplex printing Automatic duplex printing is available on all models of HP PageWide Pro 552dw 
series. Duplex printing saves the environment and saves you money.

Print multiple pages per sheet Save paper by printing two or more pages of a document side-by-side on one 
sheet of paper. Access this feature through the printer driver.

Recycling Reduce waste by using recycled paper.

Recycle cartridges by using the HP Planet Partners return process.

Energy savings Sleep modes and timer options enable this product to quickly go into reduced 
power states when not printing, thus saving energy.

Accessibility features
The product includes several features that aid users with limited vision, hearing, dexterity or strength.

● Online user guide that is compatible with text screen-readers.

● Cartridges can be installed and removed using one hand.

● All doors and covers can be opened using one hand.
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Product views
● Front view

● Back view

● Cartridge door view

Front view

Label Description

1 USB device connection port

2 Control panel

3 Tray 1 extension

4 Tray 1

5 Power button

6 Tray 2 – default paper tray

7 Cartridge door

8 Output bin
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Back view

Label Description

1 Output bin stop

2 Ethernet connection port

3 USB Type A and USB Type B ports

4 Power cord connection

5 Left door

6 Duplexer

Cartridge door view

Label Description

1 Product serial number and product number

2 Cartridge part numbers

3 Cartridge slots
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Power on and off
NOTICE: To prevent damage to the product, use only the power cord that is provided with the product.

● Turn the product on

● Manage power

● Turn the product off

Turn the product on
1. Connect the power cord that is provided with the product to the connection port on the back of the 

product.

2. Connect the power cord to a wall outlet with an adequate voltage rating.

NOTE: Make sure that your power source is adequate for the product voltage rating. The product uses 
either 100-240 Vac or 200-240 Vac and 50/60 Hz. 

3. Press and release the power button on the front of the product.

Manage power
HP PageWide Pro 552dw series printers include power-management features that can help reduce power 
consumption and save energy.

● Sleep Mode puts the product in a reduced power-consumption state if it has been idle for a specific 
length of time. You can set the length of time before the product enters Sleep Mode from the control 
panel.

● Schedule On/Off enables you to turn the product on or off automatically at days and time that you set 
from the control panel. For example, you can set the product to turn off at 6 p.m. on Monday through 
Friday.

Set the Sleep Mode time

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Power Management, and then touch Sleep Mode.

4. Select one of the time-interval options.
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The product switches into a reduced power-consumption state when it has been idle for the amount of time 
that you select.

Schedule the product to turn on or off

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Power Management, and then touch Schedule Printer On/Off.

4. Turn the Schedule On or Schedule Off option on.

5. Select the Schedule On or Schedule Off options at the bottom of the screen, and then select the day and 
time that you want to schedule.

The product switches on or off at the time you select on the day you select.

Turn the product off

NOTICE: Do not turn off the product if a cartridge is missing. Damage to the product can result. 

▲ Press and release the power button on the front of the product to turn off your HP PageWide Pro 552dw 
series printer.

A warning message appears on the control panel if you attempt to turn the product off when one or 
more cartridges are missing.

NOTICE: To prevent print-quality problems, turn off the product by using the power button on the front 
only. Do not unplug the product, turn off the powerstrip, or use any other method.
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Use the control panel
● Control panel buttons

● Control panel home screen

● Control panel dashboard

● Control panel application folders

● Control panel shortcuts

● Help features

NOTE: The small text on the control panel is not designed for prolonged viewing.

Control panel buttons
Buttons and indicator lights on the control panel of HP PageWide Pro 552dw series printers appear lit when 
their function is available, and are darkened if their function is not available.

1 Home button.

Touch to view the control panel home screen.

2 Wireless network indicator.

Solid blue when the product is connected to a wireless network. Blinks when the product is searching for a 
wireless connection. Off when the product is connected to a wired network or by a USB cable.

3 NFC (Near Field Communications) indicator.

The product can be enabled for walkup printing from tablets and smart phones.

4 Back or Cancel button.

Touch to return to the previous screen, or to cancel the current process.

5 Help button.

Touch to view the Help menu options.
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Control panel home screen
The control panel home screen displays a dashboard, application folders, and user-defined shortcuts to 
screens for performing tasks.

1 Dashboard. Dashboard icons show current product status and provide access to screens for changing product settings 
(see Control panel dashboard).

To view the full dashboard, touch the strip at the top of the home screen, or press and drag the handle at the center of the 
dashboard strip.

2 Time and date display. This section also displays scheduled events, like scheduled off time (see Schedule the product to 
turn on or off).

3 Sign in icon. The product can be set up to require users to sign in before using some applications.

Touch here to sign in with a PIN (personal identification number) or user name and password.

4 Application folders. These folders contain icons for defined tasks (for example, Print > Private Job).

Touch a folder to view the application icons that it contains.

5 Shortcuts. You can create a shortcut to any application or setup icon contained within the application folders.

Touch to show all available shortcut icons (see Control panel shortcuts).
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Control panel dashboard
To open the dashboard, touch the strip at the top of the home screen or swipe the dashboard tab downward.

To learn more about how to use the dashboard, touch  on the control panel, and then select Control Panel 
Tips > Use the Dashboard.

1 Larger icons appear across the top of the dashboard. These icons indicate the status of the product and enable you to 
change product settings.

Swipe to scroll horizontally through the available icons. Touch an icon to view a status screen or to change product 
settings.

2 A yellow or red triangle appears on an icon to indicate that user attention is required.

In the example above, a yellow warning indicates that the contents of one or more cartridges are low.

Control panel application folders
Folder icons appear on a strip across the bottom of the control panel home screen. Touch a folder icon to view 
the application icons that it contains.

Application folders for HP PageWide Pro 552dw series printers include:

● Print

● Apps

Control panel shortcuts
You can create a shortcut to any application or setup icon contained within the application folders, and then 
place that shortcut on the control panel home screen.

To learn more about how to use shortcuts, touch  and then select Control Panel Tips.
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Create a shortcut on the home screen

1. Open an application folder, and then navigate to the application or setup icon for which you want to 
create a shortcut.

2. Touch and hold the icon until the application folder strip turns green.

3. Drag the icon onto the green strip and then release it.

Remove a shortcut from the home screen

1. Touch the shortcuts icon at the lower left of the control panel home screen to display all available 
shortcuts.

2. If necessary, scroll to view the shortcut icon that you want to remove.

3. Touch and hold the shortcut icon until the application folder strip turns red.

4. Drag the icon onto the red strip and then release it.

Help features
HP PageWide Pro 552dw series printers have built-in help that is accessible from the control panel. Help 
features include tips, important product information that you can view or print, and animations that show 
how to perform tasks or solve problems.

To view these help features, touch  on the printer control panel.

● Printer information

● Help animations

Printer information

The Printer Information page displays the following information about your HP PageWide Pro 552dw series 
printer:

● Model name and number

● Product serial number
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● Product Service ID

● Current firmware version number

● Usage, status, and settings information if you print the full product information and printer status 
report pages.

View or print a Printer Information page

1. On the printer control panel, touch .

2. Touch Printer Information.

3. If you want to print the full product information and printer status report pages, touch Print.

Help animations

The built-in help contains animations that show how to perform tasks or solve problems. To select and view 
an available help animation:

1. On the printer control panel, touch .

2. Touch How To Videos.

3. Select the animation that you want to play in the printer control panel display.
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Quiet Mode
To minimize printer noise, use Quiet Mode. You can enable this mode from either the control panel or the HP 
Embedded Web Server (EWS).

NOTE: Quiet Mode slows the printer speed. If it hinders productivity, you can turn the mode off.

To turn Quiet Mode on or off from the control panel
1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 

touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Quiet Mode and turn it on or off.

To turn Quiet Mode on or off from the EWS
1. Open the EWS. For more information, see Open the EWS.

2. Click the Settings tab.

3. In the Preferences section, click Quiet Mode and turn it on or off.

4. Click Apply.
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2 Connect the product

● Connect the product to a computer or a network

● Use Wi-Fi Direct to connect a computer or device to the product

● Install HP printer software for a wireless product already on the network

● Open the printer software (Windows)

● Manage network settings
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Connect the product to a computer or a network
To connect the product using a USB cable

You can use a USB cable to connect the product to a computer.

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that 
is no longer than 2 m (6.5 ft).

NOTICE: Do not connect the USB cable until the installation software prompts you to connect it.

1. Quit all open programs on the computer.

2. Install the printer software from 123.hp.com/pagewide (recommended) or from the HP software CD 
provided with the printer, and follow the onscreen instructions.

NOTE: If you are installing on a Mac, click About HP Easy Start to install the software.

3. When prompted, select the USB-Connect the printer to the computer using a USB cable option, and 
then click the Next button.

NOTE: A dialog box displays a warning that Web Services (HP ePrint and print Apps) are unavailable 
with a USB installation. Click Yes to proceed with the USB installation, or click No to cancel it.

4. When the software prompts you, connect the Type B end of the USB cable to the connection port (1) at 
the rear of the product.

5. When the installation is complete, print a page from any program to make sure that the printing 
software is correctly installed.
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To connect the product to a network
The product supports connection to either a wired or a wireless network.

Supported network protocols

HP PageWide Pro 552 products support the following network protocols.

● TCP/IPv4

● IPv6

● DHCP, AutoIP

● DHCP v6

● HTTP server, HTTP client

● SMTP client for alerts

● SNMP v1

● Open_ssl library

● Bonjour

● gSOAP

● SAND box

● LPD

● Bootp, Bootp TCE improvement

● Netbios

● WINS

● LLMNR

● CIFS v6

Connect the product using a wired network

Use this procedure to install the product on a wired network using Windows.

1. Connect the Ethernet cable to the product (1) and to the network. Turn the product on.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns 
an IP address or host name for the product.

3. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

4. On the control panel dashboard, touch  to display the IP address. Touch Print Details to print a page 
with the IP address.

Connect the product using a wireless network (wireless models only)

You can connect the product to a wireless network using one of the following methods.

● To connect the product to a wireless network using the Wireless Setup Wizard

● To connect the product to a wireless network using WPS

● To connect the product to a wireless network manually
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If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network 
settings from your system administrator, or complete the following tasks.

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

NOTE: Before installing the product software, make sure the product is not connected to the network using 
an Ethernet cable. 

To connect the product to a wireless network using the Wireless Setup Wizard

The Wireless Setup Wizard is the best method for installing the product on a wireless network.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Network Setup, and then touch Wireless Settings.

4. Touch Wireless Setup Wizard.

5. The product scans for available wireless networks and returns a list of network names (SSIDs). Select 
the SSID for your wireless router from the list if it is available. If the SSID for your wireless router is not in 
the list, touch Enter SSID. When prompted for the type of network security, select the option that your 
wireless router uses. A keypad opens on the control panel display.

6. Do one of the following:

● If your wireless router uses WPA security, type the passphrase on the keypad.

● If your wireless router uses WEP security, type the key on the keypad.

7. Touch OK , and wait while the product establishes a connection with the wireless router. Establishing the 
wireless connection can take a few minutes.

To connect the product to a wireless network using WPS

Before you can connect your printer to a wireless network using WPS, make sure you have the following:

● A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.

NOTE: The printer supports only connections using 2.4GHz.

● A computer connected to the wireless network that you intend to connect the printer to. Be sure you 
have installed the HP printer software on the computer.

If you have a WPS router with a WPS push button, follow the Push Button method. If you are not certain your 
router has a push button, follow the PIN method.
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Push Button method

1. On the control panel, press and hold  on the printer for more than three seconds to start WPS push 
mode. The  indicator starts blinking.

2. Press the WPS button on your router.

The product begins a timer for approximately two minutes while a wireless connection is established.

PIN method

1. Locate the WPS PIN.

a. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

b. On the control panel dashboard, touch .

c. Touch Network Setup, and then touch Wireless Settings.

d. Touch Wi-Fi Protected Setup, and then touch PIN.

2. On the control panel, press and hold  on the printer for more than three seconds to start WPS push 
mode. The  indicator starts blinking.

3. Open the configuration utility or software for the wireless router or wireless access point, and then enter 
the WPS PIN.

NOTE: For more information about using the configuration utility, see the documentation provided 
with the router or wireless access point. 

4. Wait for about two minutes. If the printer connects successfully, the  indicator stops blinking but 
remains lit.

To connect the product to a wireless network manually

During the first 120 minutes of product setup, or after resetting the product's network defaults (and without a 
network cable attached to the product), the product's wireless radio will broadcast a wireless setup network 
for the product.

The name of this network is “HP-Setup-xx-[product name]”.

NOTE: The “xx” in the network name is the last two characters of the product's MAC address. The product 
name is HP PageWide Pro 552dw.

1. From a wireless enabled product, connect to the setup network for the device.

2. Open a web browser while connected to this setup network, and open the HP Embedded Web Server 
(EWS) using the following IP address.

● 192.168.223.1

3. Find the Wireless Setup Wizard in the EWS and follow the instructions to manually connect the product.

NOTE: The product uses Automatic DHCP by default.
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Use Wi-Fi Direct to connect a computer or device to the product
With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable 
device—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct

● Make sure your computer or mobile device has the necessary software.

◦ If you are using a computer, make sure you have installed the printer software from 123.hp.com/
pagewide (recommended) or from the HP software CD provided with the printer.

If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and 
then install the printer software. Select Wireless when prompted by the printer software for a 
connection type.

◦ If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit the HP Mobile Printing website.

● Make sure Wi-Fi Direct for your printer is turned on.

● Up to five computers and mobile devices can use the same Wi-Fi Direct connection.

● Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to 
a network using a wireless connection.

● Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet.

To turn on Wi-Fi Direct
1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 

touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch .

4. If the display shows that Wi-Fi Direct is off, touch Wi-Fi Direct and switch it on.

TIP: You can also turn on Wi-Fi Direct from the EWS. For more information about using the EWS, see HP 
Embedded Web Server.

To print from a wireless-capable mobile device
Make sure you have installed a compatible printing app on your mobile device. For more information, visit the 
HP Mobile Printing website.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation 
provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a 
new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks 
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shown such as DIRECT-**-HP PageWide XXXX (where ** are the unique characters to identify your 
printer and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

4. Print your document.

To print from a wireless-capable computer (Windows)
1. Make sure Wi-Fi Direct for your printer is turned on.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with 
the computer.

NOTE: If your computer does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new 
wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown 
such as DIRECT-**-HP PageWide XXXX (where ** are the unique characters to identify your printer and 
XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

NOTE: To find the password, touch  (Wi-Fi Direct) on the home screen.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless 
network. If the printer has been installed and connected to your computer with a USB cable, follow the 
steps below to install the printer software using the HP Wi-Fi Direct connection.

a. Open the printer software. For more information, see Open the printer software (Windows).

b. Click Printer Setup & Software, and then select Connect a new printer.

c. When the Connection Options software screen appears, select Wireless.

Select your HP printer software from the list of detected printers.

d. Follow the onscreen instructions.

5. Print your document.

To print from a wireless-capable computer (OS X)
1. Make sure Wi-Fi Direct for your printer is turned on.

2. Turn on Wi-Fi on the computer.

For more information, see the documentation provided by Apple.

3. Click the Wi-Fi icon and choose the Wi-Fi Direct name, such as DIRECT-**-HP PageWide XXXX (where ** 
are the unique characters to identify your printer).

If Wi-Fi Direct is turned on with security, enter the password when prompted.

4. Add the printer.

a. Open System Preferences.

b. Click Printers.
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c. Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed in the right column 
beside the printer name), and click Add.

Install HP printer software for a wireless product already on the 
network

If the product already has an IP address on a wireless network and you want to install product software on a 
computer, complete the following steps.

1. Obtain the product IP (on the control panel dashboard, touch ).

2. install the printer software from 123.hp.com/pagewide (recommended) or from the HP software CD 
provided with the printer.

3. Follow the onscreen instructions.

4. When prompted, select Wireless - Connect the printer to your wireless network and internet, and then 
click Next .

5. From the list of available printers, select the printer that has the correct IP address.

Open the printer software (Windows)
Depending on your operating system, you can open the printer software as follows:

● Windows 10: From the computer desktop, click Start, select All apps, click HP, click the folder for the 
printer, and then select the icon with the printer's name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then select 
the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

Manage network settings
● View or change network settings

● Set or change the product password

● Manually configure TCP/IP parameters from the control panel

● Link speed and duplex settings

View or change network settings
Use the HP Embedded Web Server to view or change IP configuration settings.
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1. Obtain the product IP (on the control panel dashboard, touch ).

2. Type the product IP address into the address bar of a web browser to open the HP Embedded Web 
Server.

3. Click the Network tab to obtain network information. You can change settings as needed.

Set or change the product password
Use the HP Embedded Web Server to set a password or change an existing password for a product on a 
network so unauthorized users cannot change the product settings.

1. Obtain the product IP (on the control panel dashboard, touch ).

2. Type the product IP address into the address bar of a web browser. Click the Settings tab, click Security, 
and then click the Password Settings link.

NOTE: If a password has previously been set, you are prompted to type the password. Type “admin” 
for User Name along with the password, and then click Apply.

3. Type the new password in the Password field and in the Confirm Password field.

4. At the bottom of the window, click Apply to save the password.

Manually configure TCP/IP parameters from the control panel
Use the control panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Network Setup, and then touch Ethernet Settings.

4. Touch Advanced Settings, and then touch IP Settings.

5. Touch Manual, and then touch IP Address.

6. Using the numeric keypad, do the following:

● Enter the IP address, and touch Done .

● Enter the subnet mask, and touch Done .

● Enter the default gateway, and touch Done .

7. Touch Apply.

Link speed and duplex settings

NOTE: This information applies only to Ethernet (wired) networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most 
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings 
might prevent the product from communicating with other network devices. If you need to make changes, use 
the printer control panel.
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NOTE:

● The setting must match with the network product to which you are connecting (a network hub, switch, 
gateway, router, or computer).

● Making changes to these settings causes the product to turn off and then on. Make changes only when 
the product is idle.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Network Setup, and then touch Ethernet Settings.

4. Touch Advanced Settings, and touch Link Speed.

5. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and communication 
mode allowed on the network.

10-Full 10 Mbps, full-duplex operation

10-Half 10 Mbps, half-duplex operation

100-Full 100 Mbps, full-duplex operation

100-Half 100 Mbps, half-duplex operation
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3 Printer management and services

● HP Embedded Web Server

● Web Services

● HP Web Jetadmin software

● Product security features

● HP Printer Assistant in the printer software (Windows)

● HP Utility (OS X)

● AirPrint™ (OS X)
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HP Embedded Web Server
● About the EWS

● About cookies

● Open the EWS

● Features

About the EWS
This product is equipped with the HP Embedded Web Server (EWS), which provides access to information 
about product and network activities. EWS provides an environment in which Web programs may run, much in 
the same way that an operating system, such as Windows, provides an environment for programs to run on a 
computer. The output from these programs can then be displayed by a web browser.

The EWS resides on a hardware device (such as an HP  printer) or in firmware, rather than as software that is 
loaded on a network server.

The advantage of the EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you must 
have a supported web browser on the computer. To gain access to the EWS, type the IP address for the 
product in the address bar of the browser.

About cookies
The EWS places very small text files (cookies) on your hard drive when you are browsing. These files let the 
EWS recognize your computer the next time you visit. For example, if you have configured the EWS language, 
a cookie helps remember which language you have selected so that the next time you access the EWS, the 
pages are displayed in that language. Though some cookies are cleared at the end of each session (such as 
the cookie that stores the selected language), others (such as the cookie that stores customer-specific 
preferences) are stored on the computer until you clear them manually.

IMPORTANT: The cookies that the EWS stores on your computer are used only for saving settings on your 
computer or for sharing information between the printer and the computer. These cookies are not sent to any 
HP websites.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is 
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to 
remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following features:

● Starting where you left the application (especially useful when using setup wizards).

● Remembering the EWS browser language setting.

● Personalizing the EWS home page.

For information about how to change your privacy and cookie settings and how to view or delete cookies, see 
the documentation available with your web browser.
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Open the EWS
To open the EWS, do one of the following:

● In a supported web browser, type the product IP address into the address box. (To obtain the IP address, 
on the control panel dashboard, touch .)

● In the printer software, open the HP Printer Assistant and on the Print tab, click Printer Home Page 
(EWS).

For more information, see Open the HP Printer Assistant.

● In OS X, use HP Utility or click System Preferences > Printers > HP PageWide Pro 552 > Options & 
Supplies > General > Show Printer Webpage.

NOTE: If an error occurs while opening the EWS, confirm that the proxy settings are correct for your 
network.

TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

Features
● Home tab

● Web Services tab

● Network tab

● Tools tab

● Settings tab

NOTE: Changing network settings in the EWS might disable some product or product software features.

Home tab

Use the Home tab to access frequently used items from the Web Services, Network, Tools, and Settings 
tabs. The Home tab includes the following items.

NOTE: Not all of the following items are visible by default. Use the Personalize button to show or hide the 
items of your choice.

Item Description

Energy Save Settings Configure energy-saving features that switch the printer to Sleep Mode or turn the printer on or 
off automatically

Web Services Enable or disable HP ePrint or print apps that allow you to print from email

Printer Update Check for new printer updates

Estimated Cartridge Levels Review cartridge level status

Network Summary View wired (802.3) status or wireless (802.11) status

Print Quality Toolbox Run maintenance tools to improve print quality

Wireless Setup Wizard Set up a wireless connection using the wizard
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Item Description

Wi-Fi Direct Set up Wi-Fi Direct to print from a mobile device directly to the printer without connecting to a 
wireless network

AirPrint Set up AirPrint™ for printing from Apple-supported products

Printer Information View information about the printer, such as product serial number, service ID, firmware version, 
and total page count

Administrator Set up administrator control of printer features

Backup Back up the printer settings into a password-encrypted file

Firewall Configure the network firewall

Printer Reports Print the information pages about your printer

Usage Report Display usage counters for print jobs

NOTE: Settings for this page are automatically saved in the web browser's cookies. If the web browser's 
cookies are deleted, these settings are lost.

Web Services tab

Use the Web Services tab to configure and enable HP Web Services for this product. You must enable HP Web 
Services to use the HP ePrint feature.

Network tab

Use the Network tab to configure and secure network settings for the product when it is connected to an IP-
based network. The Network tab does not appear if the product is connected to other types of networks.

Tools tab

Use the Tools tab to view or manage product utilities. The Tools tab includes the following items.

Item Description

Product Information ● Printer Information: View information about the printer, such as product serial number, 
service ID, firmware version, and total page count

● Cartridge Level Gauge: Review cartridge level status

● Cartridge Settings: Set the threshold at which the printer provides notifications that 
cartridges are running low

Reports ● Usage Report: View the number of pages processed for printing

● Printer Reports: Print various reports, such as font lists

● Event Log: View the printer's last 50 error messages

● Job Log: View a list of the most recent jobs performed by the printer

● Color Usage Job Log: View the number of pages printed in black-and-white/grayscale and 
color for all jobs and for individual jobs
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Item Description

Utilities ● Bookmarking: Bookmark pages in the EWS

● Print Quality Toolbox: Run maintenance tools to improve the print quality of your 
printouts

● Asset Tracking: Assign an asset number/location to this device

Backup and Restore ● Backup: Create a password-encrypted file that stores the printer's settings

● Restore: Restore the printer's settings using a backup file created by the EWS

Printer Restart Power Cycle: Turn off and restart the printer

Printer Updates Firmware Updates: Set up the printer to alert you of updates or to automatically install 
updates

Settings tab

Use the Settings tab to set and maintain various options on your product including power management, date 
and time, printing and paper settings, email alerts, factory defaults, and firewall settings.

Item Description

Email Alerts Set the default values for the email server, alert destinations, and alert settings

Print Settings Configure default settings for printing (such as font, print quality, duplexing, and black-and-
white or color printing)

Restore Defaults Restore the factory defaults or the network settings

Firewall Configure firewall settings such as rules, addresses, services, and other options

Web Services
● What are Web Services?

● Set Up Web Services

● Use Web Services

● Remove Web Services

What are Web Services?
The printer offers innovative, web-enabled solutions that can help you quickly access the Internet, obtain 
documents, and print them faster and with less hassle—and all without using a computer.

NOTE:  To use these web features, the printer must be connected to the Internet (either using an Ethernet 
cable or wireless connection). You cannot use these web features if the printer is connected using a USB cable.

HP ePrint

HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime, from 
any location. It's as simple as sending an email to the email address assigned to your printer when you enable 
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Web Services on the printer. No special drivers or software are needed. If you can send an email, you can print 
from anywhere, using HP ePrint.

NOTE:

● You can sign up for an account at the HP Connected website (might not be available in all countries/
regions), and sign in to configure the ePrint settings.

● After you sign up for an account at the HP Connected website, you can sign in to view your HP ePrint job 
status, manage your HP ePrint printer queue, control who can use your printer's HP ePrint email address 
to print, and get help for HP ePrint.

Print apps

● Print apps allow you to easily locate and print preformatted web content, directly from your printer. You 
can also store your documents digitally on the web.

● Preformatted content designed specifically for your printer means no cut-off text and pictures and no 
extra pages with only one line of text. On some printers, you can also choose paper and print quality 
settings on the print preview screen.

Set Up Web Services
Before you set up Web Services, make sure your printer is connected to the Internet using either an Ethernet 
or wireless connection.

To set up Web Services, use one of the following methods.

To set up Web Services using the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Web Services Setup.

4. Touch Accept to accept the Web Services terms of use and enable Web Services.

5. On the screen that appears, touch OK to allow the printer to automatically check for product updates.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the onscreen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

6. If the Printer Update Options screen appears, touch Install Automatically (Recommended) or Alert When 
Available.

7. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

To set up Web Services using the EWS

1. Open the EWS. For more information, see Open the EWS.

2. Click the Web Services tab.

ENWW Web Services 29

http://www.hpconnected.com


3. In the Web Services Settings section, click Setup, click Continue, and follow the onscreen instructions 
to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the onscreen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

Use Web Services
● HP ePrint 

● Print apps

HP ePrint

To use HP ePrint, do the following:

● Be sure you have an Internet- and email-capable computer or mobile device.

● Enable Web Services on the printer. For more information, see Set Up Web Services.

For more information about managing and configuring HP ePrint settings and to learn about the latest 
features, visit HP Connected . This site might not be available in all countries/regions.

To print documents using HP ePrint

1. On your computer or mobile device, open your email application.

2. Create a new email message, and then attach the file that you want to print.

3. Enter the HP ePrint email address in the “To” field, and then select the option to send the email 
message.

NOTE: Do not enter any additional email addresses in either the "To" or "Cc" fields. The HP ePrint 
server does not accept print jobs if there are multiple email addresses.

To find the HP ePrint email address

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Web Services Setup, and then touch Print Info Page. The printer prints an information page that 
contains the printer code and instructions on how to customize the email address.
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To turn off HP ePrint from the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch , and then touch HP ePrint and turn it off.

To turn off HP ePrint in the EWS

1. Open the EWS. For more information, see Open the EWS.

2. Click the Web Services tab.

3. In the Web Services Settings section, for HP ePrint, click Turn Off.

4. In the confirmation dialog box that appears, click Yes.

Print apps

Print apps allow you to easily locate and print preformatted web content, directly from your printer.

To use print apps

1. On the control panel, touch the Apps application folder.

2. Touch the print app you want to use.

For more information about an individual print app, visit the HP Connected website. This site might not be 
available in all countries/regions.

To manage print apps

You can add, configure, or remove print apps, and set the order in which they appear on your printer control 
panel display.

1. On the control panel, touch the Apps application folder.

2. In the display, touch the Manage icon and follow the onscreen instructions.

NOTE: You can also manage your print apps at the HP Connected website.

Remove Web Services
Use the following instructions to remove Web Services.

To remove Web Services using the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch , and then touch Remove Web Services and touch Yes.
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To remove Web Services using the EWS

1. Open the EWS. For more information, see Open the EWS.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Remove Web Services.

4. Click Remove Web Services to confirm.

5. Click Yes to remove Web Services from your printer.

HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of 
networked HP devices, including printers, multifunction products, and digital senders. This single solution 
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging 
environment — ultimately increasing business productivity by helping you save time, control costs, and 
protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product features. 
Visit the HP Web Jetadmin website, and click Download now.

Product security features
● Security statements

● Firewall

● Security settings

● Firmware updates

Security statements
This product supports security standards and protocols that help secure the product, protect information on 
your network, and simplify monitoring and maintenance of the product.

For information about HP's secure imaging and printing solutions, visit the www.hp.com/go/Secureprinting 
website. The site provides links to white papers and FAQ documents about security features and may 
include information about additional security features that are not contained in this document.

Firewall
The HP Embedded Web Server allows you to enable and configure product firewall rules, priorities, templates, 
services, and policies. The firewall feature provides a network layer of security on both IPv4 and IPv6 
networks. The firewall configuration capability gives you control over IP addresses that are allowed to access 
the product. It also lets you set permissions and priorities for digital send, management, discovery, and print 
services. All of this helps provide a more secure way of controlling access to the product.

The firewall feature also allows you to disable unused protocols and services. These protocol and services 
settings can also be protected from being changed by setting the EWS admin password. These protocols and 
services include the following.
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Protocol or service Description

IPv4 and IPv6 To operate properly on a TCP/IP network, the product must be configured with valid TCP/IP 
network configuration settings, such as an IP address that is valid for your network.

This product supports two versions of this protocol: version 4 (IPv4) and version 6 (IPv6). IPv4 
and IPv6 can be enabled/disabled individually or simultaneously enabled.

Bonjour Bonjour services are typically used on small networks for IP address and name resolution 
where a conventional DNS server is not used. The Bonjour service can be enabled or disabled.

SNMP SNMP (Simple Network Management Protocol) is used by network management applications 
for product management. This product supports the SNMPv1 protocol on IP networks. This 
product allows the ability to enable/disable SNMPv1.

WINS If you have a Dynamic Host Configuration Protocol (DHCP) service on your network, the product 
automatically obtains its IP address from that server and registers its name with any RFC 1001 
and 1002-compliant dynamic name services as long as the Windows Internet Name Service 
(WINS) server IP address has been specified.

The WINS server IP address configuration can be enable or disabled. If enabled, then the 
primary and secondary WINS server can be specified.

SLP Service Location Protocol (SLP) is an Internet standard network protocol that provides a 
framework to allow network applications to discover the existence, location and configuration 
of networked services in enterprise networks. This protocol can be enabled or disabled.

LPD Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer 
spooling services that may be installed on various TCP/IP systems. LPD can be enabled or 
disabled.

LLMNR Link-Local Multicast Name Resolution (LLMNR) is a protocol based on the Domain Name System 
(DNS) packet format that allows both IPv4 and IPv6 hosts to perform name resolution for hosts 
on the same local link. LLMNR can be enabled or disabled.

Port 9100 The product supports raw IP printing through TCP Port 9100. This HP-propriety TCP/IP port on 
the product is the default port for printing and it is accessed by HP software. Port 9100 can be 
enabled or disabled.

Web Services The product supports the ability to enable or disable Microsoft Web Services Dynamic Discovery 
(WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported 
on the product. These web services can be enabled or disabled together or WS Discovery can be 
enabled separately.

Internet Printing Protocol (IPP) Internet Printing Protocol (IPP) is an Internet-standard protocol that allows you to print 
documents and manage jobs over the internet. IPP can be disabled or enabled.

Security settings
On the Settings tab of the Embedded Web Server, under Security, you can find the following options.

Item Description

Access Control Enable and configure sign-in methods to control user access to specific printer tasks

Protect Stored Data Configure settings to protect jobs stored on the printer from unauthorized users

For more information about security settings, see the EWS administrator guide (English only).
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Firmware updates
The printer firmware can be automatically updated. On the Tools tab of the Embedded Web Server, click 
Printer Updates, Firmware Updates, and then Install updates automatically. HP recommends using this 
option.

HP Printer Assistant in the printer software (Windows)
The HP Printer Assistant provides access to HP printer features and resources from the Windows programs 
menu or the desktop icon on your computer.

Open the HP Printer Assistant
1. On your computer, click Start , and then click All Programs.

2. Click HP, click the name of the product, and then click your printer.

Features
● Connected tab

● Print tab

● Shop tab

● Help tab

● Tools tab

● Estimated Levels tab

Connected tab

Click the Connected tab to access the HP Connected website (might not be available in all countries/regions). 
HP Connected gives you a single login for select HP apps and cloud solutions plus access to the HP Connected 
platform from a smartphone, tablet, computer, or web-enabled HP printer. You can sign into HP Connected 
using your existing ePrintCenter account or sign up for a new HP Connected account.

Print tab

Use the Print tab to view or manage print utilities. This tab includes the following items.
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Item Description

Print ● Connect Printer to the Web: Click to open the HP website and get new content and solutions for 
your HP web-connected printer

● Set Preferences: Click to open your Printing Preferences dialog box to view and change defaults 
for paper size, print quality, and more

● Maintain Your Printer: Click to open the Toolbox to align and clean cartridges or print a diagnostic 
page

● Print From Your Mobile Devices: Click to open the HP Mobile Printing website to learn how to print 
from your smartphone or tablet. If a local version of this website is not available in your country/
region, you might be directed to the HP Mobile Printing site in another country/region or language.

● See What's Printing: Click to open the print monitor and view, pause, or cancel your print jobs

● Customize Your Printer: Click to open your Printing Preferences dialog box to change the name, 
security settings, or other properties of your printer

● Printer Home Page (EWS): Click to open the HP Embedded Web Server to configure, monitor, and 
maintain your printer

Shop tab

Use the Shop tab to shop for HP supplies and other products online.

Help tab

Use the Help tab to access resources such as online help and HP Eco Solutions.

Tools tab

Use the Tools tab to set and maintain the printer driver and software and to diagnose and resolve printing 
and connectivity problems.

Estimated Levels tab

Use the Estimated Levels tab to review cartridge levels and to order new cartridges, if needed.

HP Utility (OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find 
website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Cartridge level warnings and indicators provide estimates for planning purposes only. When you receive 
a low-cartridge warning message, consider having a replacement cartridge available to avoid possible 
printing delays. You do not need to replace cartridges until the print quality becomes unacceptable.

Open HP Utility

▲ Double-click HP Utility in the HP folder, in the Applications folder.
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AirPrint™ (OS X)
Your product supports printing with Apple’s AirPrint for iOS 4.2 and Mac OS X v10.9 or later. Use AirPrint to 
print wirelessly to the printer from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or 
later).

For more information, see Print with AirPrint (OS X).
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4 Paper and print media

● Understand paper use

● Supported media sizes

● Supported paper types and tray capacity

● Configure trays

● Load media

● Tips for selecting and using paper
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Understand paper use
HP PageWide cartridges for business are specifically developed for use with HP printheads. Unique 
formulations help extend the life of the printheads and enhance reliability. When used with ColorLok® paper, 
these cartridges provide laser-like color output that dries quickly and is ready for distribution.

NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using papers with 
the ColorLok® logo for this product. For details, visit the HP print permanence website.

This product supports a variety of paper and other print media. Paper or print media that does not meet the 
following guidelines might cause poor print quality, increased jams, and premature wear on the product.

It is possible for paper to meet all of these guidelines and still not produce satisfactory results. This might be 
the result of improper handling, unacceptable temperature and/or humidity levels, or other variables over 
which HP has no control.

NOTICE: Using paper or print media that does not meet HP specifications might cause problems for the 
product, requiring repair. This repair is not covered by the HP warranty or service agreements.

Use the following guidelines to obtain satisfactory results when using special paper or print media. Set the 
paper type and size in the printer driver to obtain the best results.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam extends all the way 
to the corner of the envelope.

● Do not use envelopes that are wrinkled, nicked, 
stuck together, or otherwise damaged.

● Do not use envelopes that have clasps, snaps, 
windows, or coated linings.

Labels ● Use fresh labels. Old labels are more likely to 
delaminate during printing.

● Use only labels that have no exposed backing 
between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles or bubbles, or 
are damaged.

● Do not print partial sheets of labels.

Letterhead or 
preprinted forms

● Use only letterhead or forms approved for use in 
HP PageWide products.

● Do not use raised or metallic letterhead.

Heavy paper ● Use only heavy paper that is approved for use in 
HP PageWide products and meets the weight 
specifications for this product.

● Do not use paper that is heavier than the 
recommended media specification for this product 
unless it is HP paper that has been approved for 
use in this product.

Glossy or coated 
paper

● Use only glossy or coated paper that is approved 
for use in HP PageWide products.

● Do not use glossy or coated paper designed for 
use in laser products.

NOTICE: Do not use any media that contains staples or paper clips.
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Supported media sizes
For best results, use the appropriate paper and media sizes:

● Supported paper and print media sizes

● Supported envelope sizes

● Supported card and label sizes

● Supported photo media sizes

Supported paper and print media sizes

Size Dimensions Tray 1 Tray 2 Optional Tray 3 Optional Tray 4 Electronic 
duplex printing

Letter 216 x 279 mm (8.5 x 11 
inches)

Oficio 8.5 x 13 (8.5 x 13 inches)

Oficio 216x340 mm 216 x 340 mm

Legal 216 x 356 mm (8.5 x 14 
inches)

A4 210 x 297 mm (8.3 x 
11.7 inches)

Executive 184 x 267 mm (7.25 x 
10.5 inches)

Statement 140 by 216 mm (5.5 x 
8.5 inches)

A5 148 x 210 mm (5.8 x 8.3 
inches)

A6 105 x 148.5 mm (4.13 x 
5.83 inches)

B5 (JIS) 182 x 257 mm (7.17 x 
10.12 inches)

B6 (JIS) 128x182 mm (5 x 7 
inches)

16k 184 x 260 mm (7.24 x 
10.23 inches)

195 x 270 mm (7.68 x 
10.62 inches)

197 x 273 mm (7.75 x 
10.75 inches)

Custom Minimum: 76 x 127 mm 
(3 x 5 inches)

Maximum: 216 x 356 
mm (8.5 x 14 inches)

Width: 76 to 216 
mm (3 to 8.5 
inches)

Length: 127 to 
356 mm (5 to 14 
inches)

Width: 102 to 
216 mm (4 to 
8.5 inches)

Length: 210.06 
to 297.2 mm 
(8.27 to 11.7 
inches)

Width: 102 to 
216 mm (4 to 
8.5 inches)

Length: 210.06 
to 356 mm (8.27 
to 14 inches)

Width: 102 to 
216 mm (4 to 
8.5 inches)

Length: 210.06 
to 356 mm (8.27 
to 14 inches)
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Supported envelope sizes

Size Dimensions Tray 1 Tray 2

Envelope #10 105 x 241 mm (4.13 x 9.49 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.4 x 9 inches)

Envelope B5 176 x 250 mm (6.7 x 9.8 inches)

Envelope C6 114 x 162 mm (4.5 x 6.4 inches)  

Monarch 98.4 x 190.5 mm (3.875 x 7.5 inches)  

Japanese Envelope Chou #3 120 x 235 mm (4.7 x 9.3 inches)  

Japanese Envelope Chou #4 90 x 205 mm (3.5 x 8.1 inches)  

Supported card and label sizes

Size Dimensions Tray 1 Tray 2 Optional Tray 3 Optional Tray 4

3x5 (76.2 x 127 mm) (3 x 5 inches)    

4x6 (102 x 152 mm) (4 x 6 inches)    

5x8 (127 x 203 mm) (5 x 8 inches)    

A6 (105 x 148.5 mm) (4.13 x 5.83 
inches)

   

Japanese Postcard (100 x 148 mm) (3.9 x 5.8 inches)    

Double Japan Postcard Rotated (148 x 200 mm) (5.8 x 7.9 inches)    

Labels (Letter and A4)  

Supported photo media sizes

Size Dimensions Tray 1 Tray 2 Optional Tray 3 Optional Tray 4

4x6 (102 x 152 mm) (4 x 6 
inches)

   

10x15cm (100 x 150 mm) (3.9 x 5.9 
inches)

   

L (89 x 127 mm) (3.5 x 5 
inches)

   

5x7 Photo Media (5 x 7 in 
no-tabs)

(127 x 178 mm) (5 x 7 
inches)

   

Photo Media (Letter & A4)  
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Size Dimensions Tray 1 Tray 2 Optional Tray 3 Optional Tray 4

Japanese Postcard (100 x 148 mm) (3.9 x 5.8 
inches)

Custom Minimum: 76 x 127 mm (3 x 
5 inches)

Maximum: 216 x 356 mm 
(8.5 x 14 inches)

Width: 76 to 216 
mm (3 to 8.5 
inches)

Length: 127 to 356 
mm (5 to 14 
inches)

Width: 102 to 216 
mm (4 to 8.5 
inches)

Length: 210.06 to 
297.2 mm (8.27 to 
11.7 inches)

Width: 102 to 216 
mm (4 to 8.5 
inches)

Length: 210.06 to 
356 mm (8.27 to 
14 inches)

Width: 102 to 216 
mm (4 to 8.5 
inches)

Length: 210.06 to 
356 mm (8.27 to 
14 inches)

Supported paper types and tray capacity
For best results, use the appropriate paper types and tray capacities:

● Tray 1 (multipurpose) on left side of the product

● Tray 2 (default tray) and Trays 3 and 4 (accessory trays)

Tray 1 (multipurpose) on left side of the product

Paper type Weight Capacity1 Paper orientation

Every day:

● Unspecified and Plain

● HP EcoFFICIENT

● Letterhead

● Preprinted

● Prepunched

● Light 60-74g

● Intermediate 85-95g

● Mid-Weight 96-110g

● Heavy 111-130g

● HP Premium Presentation Matte 120g

● Extra Heavy 131-175g

60 to 175 g/m2 (16 to 47 lb) Up to 50 sheets Side to be printed on face-
down, with the top edge 
toward the printer

● HP Brochure Matte 180g

● HP Brochure Glossy 180g

● Cardstock 176-220g

● HP Cover Matte 200g

● HP Advanced Photo Papers

Up to 220 g/m2 (58 lb)1 Up to 25 sheets Side to be printed on face-
down
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Paper type Weight Capacity1 Paper orientation

● Envelope

● Heavy Envelope

● Labels

 Up to 7 envelopes or labels Side to be printed on face-
down

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.

Tray 2 (default tray) and Trays 3 and 4 (accessory trays)

Paper type Weight Capacity1 Paper orientation

● Unspecified and Plain

● HP EcoFFICIENT

● Letterhead

● Preprinted

● Prepunched

● Light 60-74g

● Intermediate 85-95g

● Mid-Weight 96-110g

● Heavy 111-130g

● HP Premium Presentation Matte 120g

● Extra Heavy 131-175g

60 to 175 g/m2 (16 to 47 lb) Up to 500 sheets Side to be printed on face-up, 
with the top edge toward the 
left

● HP Brochure Matte 180g

● HP Brochure Glossy 180g

● Cardstock 176-220g

● HP Cover Matte 200g

● HP Advanced Photo Papers

Up to 220 g/m2 (58 lb) Up to 100 sheets Side to be printed on face-up

● Envelope

● Heavy Envelope

● Labels

 Up to 30 envelopes or labels.

NOTE: Trays 3 and 4 do not 
support envelope printing.

Side to be printed on face-up

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.

Configure trays
By default, the product pulls paper from Tray 2. If Tray 2 is empty, the product pulls paper from Tray 1, or 
from the optional Trays 3 or 4 if they are installed.

NOTE: If you change the default tray to Tray 1, be sure to configure the tray for the correct paper size and 
type.
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If you use special paper for all or most print jobs on the product, change this default tray setting on the 
product.

The following table lists possible ways you can use the tray settings to meet your printing needs.

Paper use Configure the product Print

Load Tray 1 and one other tray with the 
same paper, and have the product pick 
paper from one tray if the other one is 
empty.

Load paper in Tray 1, and configure the 
tray for the correct paper and type. Do not 
use Any Size/Any Type.

From the software program, print the job.

Frequently use special paper, such as 
heavy paper or letterhead, from one tray.

Load special paper in Tray 1, and configure 
the tray for the paper type.

From the software program print dialog, 
choose the paper type that matches the 
special paper loaded in the tray before 
sending the print job. Select Tray 1 as the 
Paper Source from the Paper/Quality tab 
(Windows) or Paper Feed pop-up menu (OS 
X).

Load media
● Load Tray 1

● Load Tray 2

● Load optional Tray 3

● Load optional Tray 4

● Load envelopes

● Load letterhead or preprinted forms

Load Tray 1
Tray 1 is the multipurpose tray at the left side of the product.

NOTE: If you are not using Alternate Letterhead Mode (ALM), place the paper with the side to be printed on 
face-down, with the top edge toward the printer. For ALM orientation, see Load letterhead or preprinted 
forms.

1. Open Tray 1.
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2. Pull out the Tray 1 extension.

3. Open the paper guides completely, and then load the paper stack into Tray 1.

4. Close the paper guides against the loaded media.

Load Tray 2
Tray 2 is the default (main) paper tray at the front of the product.

NOTE:  If you are not using Alternate Letterhead Mode (ALM), place the paper with the side to be printed on 
face-up, with the top edge toward the left side of the tray. For ALM orientation, see Load letterhead or 
preprinted forms.

1. Pull the tray out of the product.
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2. Open the paper length and width guides completely.

3. Place the paper in the tray and make sure that it is flat at all four corners. Close the length and width 
paper guides against the loaded media.

4. Push down on the paper to make sure that the stack is below the paper limit tabs on the side of the tray.

5. Put the tray into the product.

Load optional Tray 3
Tray 3 is an optional accessory tray that attaches to the bottom of the product. It can hold longer media, such 
as legal (216 x 356 mm, 8.5 x 14 inches) paper.

NOTE:  If you are not using Alternate Letterhead Mode (ALM), place the paper with the side to be printed on 
face-up, with the top edge toward the left side of the tray. For ALM orientation, see Load letterhead or 
preprinted forms.

1. Pull the tray out of the product.
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2. Open the paper length and width guides completely.

3. Place the paper in the tray and make sure that it is flat at all four corners. Close the length and width 
paper guides against the loaded media.

4. Push down on the paper to make sure that the stack is below the paper limit tabs on the front and the 
side of the tray.

5. Put the tray into the product.
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Load optional Tray 4
Tray 4 is available only in a bundle with Tray 3 and a cart. Tray 3 attaches to the bottom of the product. Tray 4 
attaches to the bottom of Tray 3 and sits on top of the cart. Load media into Tray 4 as you did for Tray 3.

Load envelopes
You can load envelopes into Tray 1 or Tray 2.

To load envelopes into Tray 1

1. Open Tray 1.

2. Pull out the Tray 1 extension.
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3. Place envelopes in Tray 1 face-down, with the top of the envelope oriented toward the front of the 
printer.

4. Close the paper guides.

To load envelopes into Tray 2

1. Pull the tray out of the product.

2. Stack envelopes face-up, with the top of the envelopes oriented toward the front of the tray.

3. Place the envelopes in the tray and make sure that they are flat at all four corners. Close the length and 
width paper guides against the loaded media.

4. Push down on the envelopes to make sure that the envelopes are below the paper limit tabs on the side 
of the tray.

5. Put the tray into the product.
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Load letterhead or preprinted forms
You can load letterhead, preprinted, or prepunched forms into any tray. Paper orientation depends on 
whether you are printing in simplex or duplex mode. If Alternative Letterhead Mode (ALM) is enabled, you can 
print in both simplex and duplex modes without reorienting the paper.

NOTE: With ALM enabled, you must select Letterhead, Preprinted, or Prepunched as the paper type in the 
Printer Properties dialog box.

To enable or disable ALM from the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Tray and Paper Management, and then touch Alternative Letterhead Mode and turn it on or off.

To enable or disable ALM from the EWS

1. Type the product IP address into the address box of a web browser to open the EWS. (To obtain the 
product IP, on the control panel dashboard, touch .)

2. Click the Settings tab.

3. Click Preferences , and then click Tray and Paper Management.

4. In the Alternative Letterhead Mode section, select Enabled or Disabled.

5. Click Apply.

To load letterhead or preprinted forms with ALM enabled

1. Depending on the tray, orient the paper as follows.

Tray 1 Other tray(s)

Place the letterhead face-up, with the top of the page oriented 
toward the left.

Place the letterhead face-down, with the top of the page 
oriented toward the right.

2. Complete the steps in Load Tray 1, Load Tray 2, Load optional Tray 3, or Load optional Tray 4.

To load letterhead or preprinted forms with ALM disabled

1. Depending on the tray, orient the paper as follows.

Tray 1 Other tray(s)

Simplex Place the letterhead face-down, with the top of 
the page oriented toward the right.

Place the letterhead face-up, with the top of the 
page oriented toward the left.

Duplex Place the letterhead face-up, with the top of the 
page oriented toward the left.

Place the letterhead face-down, with the top of 
the page oriented toward the right.

2. Complete the steps in Load Tray 1, Load Tray 2, Load optional Tray 3, or Load optional Tray 4.
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Tips for selecting and using paper
For the best results, observe the following guidelines.

● Load only one type of paper at a time into the tray.

● Make sure the paper is loaded correctly when loading from the tray.

● Do not overload the tray.

● To prevent jams, poor print quality, and other printing problems, avoid loading the following paper in the 
tray:

◦ Multipart forms

◦ Media that is damaged, curled, or wrinkled

◦ Media with cutouts or perforations

◦ Media that is heavily textured, embossed, or otherwise difficult to print on

◦ Media that is too lightweight or stretches easily

◦ Media that contains staples or clips
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5 Cartridges

● HP PageWide cartridges

● Manage cartridges

● Replace cartridges

● Tips for working with cartridges
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HP PageWide cartridges
HP policy on non-HP cartridges

IMPORTANT:

● HP does not guarantee the quality or reliability of non-HP contents in HP cartridges.

● HP’s cartridge warranty does not cover non-HP cartridges or cartridges with non-HP contents.

● HP’s printer warranty does not cover repairs or service due to use of non-HP cartridges or cartridges 
with non-HP contents.

NOTE:

● This printer is not designed to use continuous ink systems. To resume printing, remove the continuous 
ink system and install original HP (or compatible) cartridges.

● This printer is designed for cartridges to be used until they are empty. Refilling cartridges before they 
are depleted might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP 
or compatible) to continue printing.

Counterfeit HP cartridges
Your cartridge might not be a genuine HP cartridge if you notice the following:

● The control panel or printer status report indicates that a used or counterfeit cartridge is installed.

● You are experiencing a high number of problems with the cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).

Visit the HP anticounterfeit website when you install an HP print cartridge and the control panel message 
says the cartridge is used or counterfeit. HP will help resolve the problem.

Manage cartridges
Correctly storing, using, and monitoring cartridges can help ensure high-quality print output and extend the 
life of cartridges.

● Store cartridges 

● Print with General Office mode

● Print when a cartridge is at estimated end of life

● Check the estimated cartridge levels

● Order cartridges

● Recycle cartridges
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Store cartridges 
● Do not remove the cartridge from its package until you are ready to use it.

● Store cartridges at room temperature (15-35° C or 59-95° F) for at least 12 hours before using them.

● Handle cartridges carefully. Dropping, jarring, or rough handling during installation can cause temporary 
printing problems.

Print with General Office mode
General Office mode produces slightly lighter printouts, which might extend the life of the cartridge.

1. On the File menu in the software program, click Print.

2. Make sure your printer is selected.

3. Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options, 
Printer Setup, Printer Properties, Printer, or Set Preferences.

Do one of the following.

● Windows: Click Print Options, and then click Properties.

● OS X: From the pop-up menu, select Copies and Pages.

4. Click the Paper/Quality tab.

5. Select General Office from the Print Quality drop-down list (Windows) or pop-up menu (OS X).

Print when a cartridge is at estimated end of life
Supply-related notifications are communicated on the printer control panel.

● Cartridge Low message appears when a cartridge is nearing the estimated end of its useful life. Printing 
can continue, but consider having a replacement cartridge available.

● Cartridge Very Low message appears when the cartridge is near its estimated end of useful life. Have a 
replacement cartridge available.

● Cartridge Depleted message appears when the cartridge is empty.

NOTE: Although using the Continue setting allows printing beyond Cartridge Very Low without replacing 
the cartridge, the product will shut down before any print problems occur.

Check the estimated cartridge levels
You can check the estimated cartridge levels from the printer control panel or from the printer software.

To check the cartridge levels from the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch  to display the estimated cartridge levels.
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To check the cartridge levels from the EWS

1. Open the EWS. For more information, see Open the EWS.

2. Click the Tools tab, and then click Cartridge Level Gauge.

To check the cartridge levels from the product software (Windows)

1. Open the HP Printer Assistant. For more information, see Open the HP Printer Assistant.

2. On the Print tab, click Maintain Your Printer.

3. Click the Estimated Cartridge Levels tab.

To check the cartridge levels from the product software (OS X)

1. Open HP Utility. For more information, see Open HP Utility.

2. Make sure your printer is selected.

3. Click Supplies Status.

The estimated cartridge levels appear.

4. Click All Settings to return to the Information and Support pane.

NOTE:

● If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another 
printer, the cartridge level indicator might be inaccurate or unavailable.

● Cartridge-level alerts and indicators provide estimates for planning purposes only. When you receive 
a low-cartridge alert, consider having a replacement cartridge available to avoid possible printing 
delays. You do not need to replace the cartridges until you are prompted to.

● Ink from the cartridges is used in the printing process in a number of different ways, including in the 
initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, 
which keeps the cartridges printing smoothly. Some residual ink is left in the cartridge after it is used. 
For more information, visit the HP SureSupply website.

Order cartridges
To order cartridges, visit the HP website . (At this time, some portions of the HP website are available in 
English only.) Ordering cartridges online is not supported in all countries/regions. However, many countries 
have information on ordering by telephone, locating a local store, and printing a shopping list. In addition, you 
can visit the HP SureSupply website to obtain information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the cartridge you are replacing. 
You can find the cartridge number in the following places:

● On the label of the cartridge you are replacing.

● On a sticker inside the printer. Open the cartridge access door to locate the sticker.

● In the printer software, open the HP Printer Assistant, click Shop, and then click Shop For Supplies 
Online.

● In the HP Embedded Web Server, click the Tools tab and then, under Product Information, click 
Cartridge Level Gauge. For more information, see HP Embedded Web Server.
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NOTE: The SETUP cartridge that comes with the printer is not available for separate purchase.

Recycle cartridges
Visit the HP sustainability website for full information on recycling and to order postage-paid labels, 
envelopes, and boxes for recycling.

Replace cartridges
The product uses four colors and has a different cartridge for each color: yellow (Y), magenta (M), cyan (C), 
and black (K).

NOTICE:

● To prevent print-quality problems, HP recommends replacing any missing cartridges with genuine HP 
cartridges as soon as possible. For more information, see Order cartridges.

● Never turn off the printer if any cartridges are missing.

1. Open the cartridge door.

2. Push the old cartridge inward to unlock and release it.

3. Grasp the edge of the old cartridge and then pull the cartridge straight out to remove it.
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4. Do not touch the metal contacts on the cartridge. Fingerprints on the contacts can cause connection 
errors.

5. Insert the new cartridge into its slot.

6. Close the cartridge door.
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Tips for working with cartridges
Use the following tips to work with cartridges:

● To prevent print-quality problems, do the following:

◦ Always turn the printer off using the power button on the front, and wait until the power button 
light goes out.

◦ Make sure that all the cartridge slots are filled.

● If you remove a cartridge from the printer for any reason, try to replace it again as soon as possible.

● Do not open or unpackage cartridges until you are ready to install them.

● Insert the cartridges into the correct slots. Match the color and icon of each cartridge to the color and 
icon for each slot. Make sure the cartridges snap into place.

● When the Estimated Cartridge Levels screen shows one or more cartridges in a low state, consider 
getting replacement cartridges to avoid possible printing delays. You do not need to replace the 
cartridges until prompted to. See Replace cartridges for more information.

● Do not clean the printhead unnecessarily. This shortens the life of the cartridges.

● If you are transporting the printer, do the following to prevent leaking from the printer or other damage 
from occurring.

◦ Make sure you turn off the printer by pressing the power button in the front. Wait until all sounds 
of internal motion stop before unplugging the printer.

◦ Make sure you leave the cartridges installed.

◦ The printer must be transported sitting flat; it should not be placed on its side, back, front, or top.
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6 Print

● Print from a computer

● Print from the control panel

● Print with NFC

● Print with HP ePrint

● Print with AirPrint (OS X)

● Tips for print success
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Print from a computer
To print from a computer (Windows)

These instructions apply to printing on various media including the following.

● Plain paper

● Letterhead or preprinted forms

● Envelopes

● Photos

● Brochures

● Labels

To print from a computer (Windows)

1. Load the supported media in the correct tray.

For more information, see Supported media sizes.

2. On the File menu in the software program, click Print.

3. Make sure your printer is selected.

4. Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options, 
Printer Setup, Printer Properties, Printer, or Set Preferences.

5. Set the correct print options for your type of media (plain paper, letterhead or preprinted, envelope, 
photo paper, label, and so forth).

The following table describes the tabs and options that might be available in your software program.

Tab Description

Printing Shortcuts A printing shortcut stores the settings that are appropriate for a particular kind of job, so that you 
can set all the options with a single click.

This tab displays the current printing shortcuts and their settings, such as paper type, paper 
source, and color or grayscale.

Paper/Quality This tab contains settings that define the type of print job. For example, printing on envelopes 
requires different size, source, and type of paper than printing on plain paper.

You can select from the following options:

● Paper size: Includes Letter, Envelope #10, and Japanese Envelope Chou #3

● Paper source: Includes Printer Auto Select, Manual Feed, Tray 1, and Tray 2

● Paper type: Includes Plain, Letterhead, Preprinted, Envelope, HP Advanced Photo Papers, 
HP Brochure Matte 180g, and Labels

NOTE: If Alternative Letterhead Mode (ALM) is enabled, and you are printing on 
letterhead, preprinted, or prepunched forms, select Letterhead, Preprinted, or Prepunched 
as the paper type. For more information, see Load letterhead or preprinted forms.

● Special pages: Includes front and back covers, blank sheets, and preprinted sheets

● Print quality: Includes Professional (for high-quality jobs) and General Office (for everyday 
jobs)

NOTE: You cannot print envelopes in General Office mode.
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Tab Description

Effects This tab contains settings that temporarily affect the presentation of the print job.

You can select from the following options:

● Resizing options: Includes actual size, a percentage of actual, or scaled to a specific media 
size such as Letter or Envelope #10

● Watermarks: Includes Confidential and Draft

Finishing This tab contains settings that influence the output of the print job.

You can select from the following options:

● Print on both sides: Includes the option to print with room for binding on the left, right, or 
neither side

● Pages per sheet: Print more than one page per sheet, with the option to print borders 
around each page

● Orientation: Includes Portrait and Landscape

Job Storage This tab contains settings for printing a stored job from the control panel. Only one setting is 
described here:

● Off (default): Prints a job without storing it on the printer

For information about the other settings, see Print using job storage.

Color This tab contains settings for printing in color or grayscale.

You can select from the following:

● Print in Grayscale: Print in black ink only, or high-quality grayscale (which uses the color 
cartridges in addition to the black cartridge)

● Color Themes: These options determine how colors are rendered. They include various red-
green-blue themes such as in Default, Photo, or Vivid. For more information, see To adjust 
or manage colors.

Advanced This tab contains settings that you may use or change infrequently.

You can select from the following:

● Copies: Select the number of copies and whether to collate them

● Reverse page order: Prints from the last page of the job to the first page

● Print all text as black: Helps reduce color cartridge usage

● Ink Settings: Use the sliders to select the dry time, saturation level, and black ink spread 
for the print job. For more information, see To adjust or manage colors.

6. Click OK to return to the Properties dialog box.

7. Click OK , and then click Print or click OK in the Print dialog box.

NOTE: After printing, remove any special media, such as envelopes or photo paper, from the product.

To print from a computer (OS X)
These instructions apply to printing on various media including the following.
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● Plain paper

● Letterhead or preprinted forms

● Envelopes

● Photos

● Brochures

● Labels

To print from a computer (OS X)

1. Load the supported media in the correct tray.

For more information, see Supported media sizes.

2. On the File menu in the software program, click Print.

3. Make sure your printer is selected.

4. In the Presets menu, select a printing preset if needed.

5. On the Paper/Quality tab, click the pop-up menu next to the media type.

Set the correct print options for your media (plain paper, letterhead, preprinted, prepunched, envelope, 
photo paper, label, and so forth). Print options can include size, type, tray, print resolution, and 
automatic adjustments.

If you do not see options on the Print dialog box, click Show Details.

6. Click Print .

NOTE: After printing, remove any special media, such as envelopes or photo paper, from the product.

To set up printing shortcuts (Windows)
1. On the File menu in the software program, click Print.

2. Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options, 
Printer Setup, Printer Properties, Printer, or Set Preferences.

3. Click the Printing Shortcuts tab.

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before adjusting any of the settings on the right side of the screen. If 
you adjust the settings and then select a shortcut, all your adjustments are lost.

5. Select the print options for the new shortcut.

6. Click the Save As button.

7. Type a name for the shortcut, and click the OK button.

To set up printing presets (OS X)
1. On the File menu in the software program, click Print.

2. Make sure your printer is selected.

3. From the Presets pop-up menu, select Default Settings.
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4. Click Save Current Settings as Preset.

5. Type a descriptive name for the preset, and save it for Only this printer or All printers.

To adjust or manage colors
Adjust the color of print output for the product by changing the settings in the printer driver software.

● Choose a preset color theme for a print job

● Adjust the color options for a print job manually

● Match colors to your computer screen

● Control access to color printing

Choose a preset color theme for a print job

1. On the File menu in the software program, click Print.

2. Make sure your printer is selected.

3. Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options, 
Printer Setup, Printer Properties, Printer, or Set Preferences.

4. Click the Color tab, and select a color theme from the Color Themes drop-down list (Windows) or the 
RGB Color pop-up menu (OS X).

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this 
theme, manage color in the software program or in the operating system for correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when printing 
business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital mini 
lab. The product renders deeper, more saturated colors differently than with the Default (sRGB) 
theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color 
space rather than sRGB. Turn off color management in the software program when using this 
theme.

● None: No color theme is used.

Adjust the color options for a print job manually

Use the printer driver software to clear default color settings and adjust settings manually. Use the built-in 
help in the driver software to understand how each setting affects print output.

1. On the File menu in the software program, click Print.

2. Make sure your printer is selected.

3. Do one of the following.

● Windows: Click the link or button that opens the Properties dialog box.
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Depending on your software application, this link or button might be called Properties , Options, 
Printer Setup, Printer Properties, Printer, or Set Preferences.

● OS X: From the Copies & Pages pop-up menu, select Color. Then, deselect HP EasyColor.

4. Continue to the Advanced tab or pane.

● Windows: On the Advanced tab, click Ink Settings.

● OS X: Click the disclosure triangle next to Advanced.

5. Use the sliders to make the following adjustments.

● Dry Time: Move the slider to the right to increase the amount of time that the printer takes to dry a 
printed page. Increasing the drying time works best for jobs printed on plain paper.

● Saturation: Move the slider to the right to increase the amount of ink applied. Increasing the 
saturation works best for jobs printed on brochure or photo paper.

● Black Ink Spread: Move the slider to the left to limit the spread of black ink onto adjacent areas of 
color on the printed page. Decreasing the spread works best for jobs printed on plain paper.

NOTE: Changing color settings manually can affect output. HP recommends that only color 
graphics experts change these settings.

6. Click OK to save your adjustments and close the window, or click Reset to return the settings to the 
factory defaults (Windows).

Match colors to your computer screen

For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers and 
computer monitors use different methods of producing color. Monitors display colors by using light pixels 
that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan, magenta, 
yellow, and black) process.

Many factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printing process (cartridge, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)
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Control access to color printing

HP’s suite of color access control tools allows you to enable or disable color by individual users or groups and 
applications. For more information, visit the HP Universal Print Driver website.

Print from the control panel
Print using job storage

You can create and store jobs on the product, which you or others can print later. To save printer memory or 
to protect sensitive information, you can delete the stored jobs from the product.

● To enable job storage

● To apply job storage to one or all print jobs

● To print a job stored on the printer

● To delete a job stored on the printer

To enable job storage

Job storage is enabled, by default. You can disable or re-enable it, as needed.

Disable or enable job storage (Windows)

1. Click Start, and do one of the following, depending on your operating system.

● Windows 10: Click Settings, click Devices, and then click Printers.

● Windows 8, 8.1: Click Control Panel, click Hardware and Sound, and then click Devices and 
Printers.

● Windows 7: Click Devices and Printers.

2. Right-click your printer, and then click Properties or Printer properties.

3. In the Printer Properties window, click the Device Settings tab.

4. From the Job Storage drop-down list, select Disable to turn the feature off or select Automatic to turn it 
on.

5. Click Apply, and then click OK.

Disable or enable job storage (OS X)

1. Open HP Utility. For more information, see Open HP Utility.

2. Make sure your printer is selected.

3. Click Devices.

4. Select Allow Stored Jobs on this printer, and set the storage job settings.

To apply job storage to one or all print jobs

You can apply the job storage feature to a single job or to all print jobs. When you do this, the single job or all 
jobs are stored in the printer memory so that you can print them later from the printer control panel.
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Apply job storage to one or all print jobs (Windows)

1. Do one of the following.

● For one print job: On the File menu in the software program, click Print.

● For all print jobs: Click Start, and do one of the following, depending on your operating system.

◦ Windows 10: Click Settings, click Devices, and then click Printers.

◦ Windows 8, 8.1: Click Control Panel, click Hardware and Sound, and then click Devices and 
Printers.

◦ Windows 7: Click Devices and Printers.

2. Make sure your printer is selected.

3. Continue to the Job Storage tab.

● For one print job: Click the link or button that opens the Properties dialog box. Then, click the Job 
Storage tab.

● For all print jobs: Right-click your printer, click Printing preferences, and then click the Job 
Storage tab.

4. On the Job Storage tab, select one of the following options:

● Proof and Hold: Prints the first copy of a multiple-copy job so you can verify the print quality and 
prints the remaining copies when you request them at the printer control panel

● Personal Job: Does not print the job until you request it at the printer control panel

● Quick Copy: Prints the requested number of copies of the job and stores a copy of it so you can 
print it again later

● Stored Job: Prints the job on the printer and lets other users print it at any time

● Make Job Private/Secure: Applies to Personal or Stored Jobs. You can require a personal 
identification number (PIN) or password to print the stored job from the control panel.

◦ None: No PIN or password is required.

◦ PIN to print: A four-digit PIN is required.

◦ Encrypt Job (with password) (for Windows 7 or later): A password, consisting of 4-32 
characters, is required.

5. To use a custom user name or job name, click Custom and then type the user name or the job name.

If you type a job name that is already in use, select one of the following:

● Use Job Name + (1-99): Append a unique number to the end of the job name

● Replace Existing File: Overwrite the existing stored job with the new one

6. Click OK , and then click Print to store the job on the printer.

Apply job storage to one or all print jobs (OS X)

1. Do one of the following.
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● For one print job: On the File menu in the software program, click Print. Then, in the pop-up menu 
below Presets, select Job Storage.

● For all print jobs: From the Copies & Pages pop-up menu, select Job Storage.

2. Make sure your printer is selected.

3. From the Mode pop-up menu, select one of the following options:

● Quick Copy: Prints the requested number of copies of the job and stores a copy of it so you can 
print it again later

● Proof and Hold: Prints the first copy of a multiple-copy job so you can verify the print quality and 
prints the remaining copies when you request them at the printer control panel

● Stored Job: Prints the job on the printer and lets other users print it at any time

● Personal Job: Does not print the job until you request it at the printer control panel

4. To use a custom user name or job name, click Custom and then type the user name or the job name.

● If you type a job name that is already in use, select one of the following:

◦ Use Job Name + (1-99): Append a unique number to the end of the job name

◦ Replace Existing File: Overwrite the existing stored job with the new one

5. For Personal or Stored Jobs, select Use PIN to Print if you want to require a four-digit personal 
identification number (PIN) to print the stored job from the control panel.

6. Click Print to store the job on the printer.

To print a job stored on the printer

1. On the control panel, touch the Print application folder.

2. In the display, touch the Job Storage icon.

3. Navigate to the stored job you want, and open it.

NOTE: If the job is private or encrypted, enter the PIN or password.

4. Select the number of copies, and touch Print.

To delete a job stored on the printer

1. On the control panel, touch the Print application folder.

2. In the display, touch the Job Storage icon.

3. Open the folder containing your stored job, and do one of the following.

● To delete one job, touch the job you want to delete.

● To delete all the jobs in the folder, touch the trash icon, and then touch Delete.

NOTE: If some jobs are protected with a PIN or password, touch All jobs without a PIN or 
password or All jobs with the same PIN or password and follow the onscreen instructions.
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NOTE: If the job is private or encrypted, enter the PIN or password.

4. If needed, touch the trash icon, and then touch Delete.

Print from a USB device
This product features printing directly from a USB storage device (Plug and Print), so you can quickly print 
files without sending them from a computer. The product accepts standard USB storage accessories in the 
USB port near the control panel.

You can print the following types of files.

● .DOC

● .DOCX

● .JPEG

● .JPG

● .PDF

● .PNG

● .PPT

● .PPTX

● .TIFF

1. Insert the USB device into the USB port on the front of the product. The Memory Device Options menu 
opens.

2. In the display, touch the Print Documents icon.

3. Navigate to the job you want on the USB device, and open it.

4. Select the number of copies, and touch Start Black or Start Color to start printing.

Print with NFC
With Near Field Communications (NFC), you can walk up to the product and print from your smart phone or 
tablet. To print using NFC, in the control panel touch , and follow the onscreen instructions.

Print with HP ePrint
With HP ePrint, you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile device. 
HP ePrint works with any email-capable device. If you can email, you can print to an HP ePrint-enabled 
product. For more details, visit the HP Connected website.

To use HP ePrint, ensure the following:

● You have an Internet- and email-capable computer or mobile device.

● HP Embedded Web Server and HP ePrint are enabled on the printer. For more information, see HP 
Embedded Web Server.

Print off site by sending an email with the HP ePrint app
If you are on the road, you can print a document by sending an email with the HP ePrint app to your HP ePrint-
enabled printer. See Web Services for more information.

NOTE: Obtain your HP ePrint email address while in the office. For instructions, see To find the HP ePrint 
email address.
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1. On your computer or mobile device, open your email application.

2. Create a new email message, and then attach the file that you want to print.

3. Enter the HP ePrint email address in the “To” field, and then select the option to send the email 
message.

NOTE: Do not enter any additional email addresses in either the "To" or "Cc" fields. The HP ePrint 
server does not accept print jobs if there are multiple email addresses.

Print from an on-site computer or mobile device
If you are at home or in the office, you can print from a smartphone or tablet to your printer easily.

NOTE: If you want to print without accessing the network, see Use Wi-Fi Direct to connect a computer or 
device to the product for more information.

1. Make sure your mobile device and printer are on the same network.

2. Select the photo or document you want to print and choose your printer.

3. Confirm print settings and print.

Print with AirPrint (OS X)
Printing using Apple’s AirPrint is supported for iPad (iOS 4.2), iPhone (3GS or later), iPod touch (third 
generation or later), and Mac (OS X v10.9 or later).

To use AirPrint, ensure the following:

● The printer and the Apple device are connected to the same network as your AirPrint-enabled device. For 
more information, visit the HP Mobile Printing website. If a local version of this website is not available 
in your country/region, you might be directed to the HP Mobile Printing site in another country/region or 
language.

● Load paper that matches the paper settings of the printer.

To re-enable AirPrint

AirPrint is enabled, by default. If it becomes disabled, you can use the following instructions to enable it 
again.

1. Open the EWS. For more information, see Open the EWS.

2. On the Network tab, click AirPrint and then click Status.

3. In the AirPrint Status row, click Turn On AirPrint.
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Tips for print success
● Cartridge tips

● Paper loading tips

● Printer settings tips (Windows)

● Printer settings tips (OS X)

Cartridge tips
● If the print quality is unacceptable, see Improve print quality for more information.

● Use Original HP cartridges.

Original HP cartridges are designed and tested with HP printers and papers to help you easily produce 
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP cartridges. Product service or repairs 
required as a result of using a non-HP cartridge will not be covered under warranty.

If you believe you purchased Original HP cartridges, visit the HP anticounterfeit website.

● Install the black and color cartridges correctly.

For more information, see Replace cartridges.

● Check the estimated cartridge levels to make sure there is sufficient ink.

Supply level warnings and indicators provide estimates for planning purposes only.

For more information, see Check the estimated cartridge levels.

NOTE: When you receive a low-cartridge warning message, consider having a replacement cartridge 
available to avoid possible printing delays. You do not need to replace the cartridges until prompted to.

● To protect the product from damage, always turn off the printer by using the power button on the front.

Paper loading tips
For more information, see Supported media sizes.

● Ensure the paper is loaded in the input tray properly, and set the correct media size and media type. 
Upon loading paper in input tray, you will be prompted to set the media size and media type.

● Load a stack of paper (not just one page). All the paper in the stack should be of the same size and type 
to avoid a paper jam.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the guides do 
not bend the paper in the tray.

Printer settings tips (Windows)
● To change default print settings, do one of the following:
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◦ In the HP Printer Assistant, click Print , and then click Set Preferences. For more information, see
Open the HP Printer Assistant.

◦ On the File menu in the software program, click Print. Open the Printer Properties dialog box.

● On the Color or Finishing tab of the printer driver, set the following options as needed:

◦ Print in Grayscale: Allows you to print a black-and-white document using only the black cartridge.
Click Black Ink Only, and then click OK .

◦ Pages per sheet: Helps you specify the order of the pages if you print document in more than two
pages per sheet.

◦ Booklet Layout: Allows you to print a multiple-page document as a booklet. It places two pages on
each side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding
method from the drop-down list, and then click OK .

● Left binding: The binding side after folded into a booklet appears at the left side. Select the
option if your reading habit is from left to right.

● Right binding: The binding side after folded into a booklet appears at the right side. Select
the option if your reading habit is from right to left.

◦ Print page borders: Allows you to add the borders to the pages if you print the document with two
or more pages per sheet.

● You can use printing shortcuts to save time setting printing preferences.

Printer settings tips (OS X)
● In the software program, be sure to select the correct paper size loaded in the printer.

a. From the File menu, select Page Setup.

b. In Format For, make sure your printer is selected.

c. From the pop-up menu, select Paper Size.

● In the software program, be sure to select the correct paper type and quality loaded in the printer.

a. On the File menu in the software program, click Print.

b. From the Copies & Pages pop-up menu, select Paper/Quality, and select the correct paper type
and quality.

● To print a black-and-white document using only the black cartridge, do the following.

a. On the File menu in the software program, click Print.

b. In the Print window, from the pop-up menu, select Copies & Pages, and then select Color.

c. Deselect HP EasyColor, and then select Print Color as Gray.

d. Select Black Ink Only.
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7 Solve problems

● Problem-solving checklist

● Information pages

● Factory-set defaults 

● Cleaning routines

● Jams and paper-feed issues

● Cartridge issues

● Printing issues

● Connectivity issues

● Wireless network issues

● Product software issues (Windows)

● Product software issues (OS X)
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Problem-solving checklist
Follow these steps when trying to solve a problem with the product.

● Check that the product power is on

● Check the control panel for error messages

● Test print functionality

● Try sending a print job from a computer

● Test the plug-and-print USB functionality

● Factors that affect product performance

Check that the product power is on
1. If the power button is not lit, press it to turn the product on.

2. If the power button does not seem to work, ensure that the power cable is connected to both the 
product and the electrical or AC outlet.

3. If the product is still not powering up, check the power source by connecting the power cable to a 
different electrical or AC outlet.

Check the control panel for error messages
The control panel should indicate ready status. If an error message appears, resolve the error.

Test print functionality
1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 

touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Reports , and then touch Printer Status Report to print a test page.

4. If the report does not print, make sure paper is loaded in the tray, and check the control panel to see if 
paper is jammed inside the product.

NOTE: Make sure the paper in the tray meets specifications for this product.

Try sending a print job from a computer
1. Use a word-processing program to send a print job to the product.

2. If the job does not print, make sure you selected the correct printer driver.

3. Uninstall and then reinstall the product software.
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Test the plug-and-print USB functionality
1. Load a .PDF document or .JPEG photo onto a USB flash drive, and insert it in the slot on the front of the 

product.

2. The Memory Device Options menu opens. Try printing the document or photo.

3. If no documents are listed, try a different type of USB flash drive.

Factors that affect product performance
Several factors affect the time it takes to print a job:

● The software program that you are using and its settings

● The use of special paper (such as heavy paper and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● Whether the product is printing in color or in monochrome

● The type of USB drive, if you are using one

Information pages
Information pages reside within the product memory. These pages help diagnose and solve problems with 
the product.

NOTE: If the product language was not correctly set during installation, you can set the language manually 
so the information pages print in one of the supported languages. Change the language by using the 
Preferences menu on the Setup menu in the control panel or by using the HP Embedded Web Server.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Reports to view the menu.

4. Touch the name of the report that you want to print.

Menu Item Description

Printer Status Report Prints the cartridge status. Includes the following information:

● Estimated proportion of cartridge life remaining
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Menu Item Description

NOTE: Cartridge-level alerts and indicators provide estimates for planning purposes only. When you 
receive a low-cartridge alert, consider having a replacement cartridge available to avoid possible printing 
delays. You do not need to replace the cartridges until you are prompted to.

● Approximate number of pages remaining

● Part numbers for HP cartridges

● Number of pages printed

● Information about ordering new HP cartridges and recycling used HP cartridges

Print Quality Report Prints a page that helps solve problems with print quality

Web Access Test Report Shows the current configuration settings and diagnostic results for the local network, gateway, DNS, proxy, 
and test server. This report is useful for resolving problems accessing the web.

Usage Page Shows a count of all paper sizes that have passed through the product; lists whether they were monochrome 
or color, simplex or duplex, and reports the page count. This report is useful for reconciling contractual billing 
statements.

Network Configuration Page Displays status for:

● Network hardware configuration

● Enabled features

● TCP/IP and SNMP information

● Network statistics

● Wireless network configuration (wireless models only)

Event Log Prints a log of errors and other events during product use.

PCL Font List Prints a list of all installed PCL  fonts

PCL6 Font List Prints a list of all installed PCL6  fonts

PS Font List Prints a list of all installed PS fonts

Factory-set defaults 
NOTICE: Restoring the factory-set defaults returns all of the product and network settings to the factory 
defaults. The procedure then automatically restarts the product.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Printer Maintenance, and then touch Restore.

4. Touch Restore Factory Defaults, and then touch Continue.

The product automatically restarts.
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Cleaning routines
● Clean the printhead

● Clean the touch screen

Clean the printhead
During the printing process, paper, ink, and dust particles can accumulate inside the product. Over time, this 
buildup can cause print-quality problems such as specks or smearing.

This product automatically services itself, running cleaning routines that can correct most of these problems.

For problems that the product cannot automatically solve, use the following routine to clean the printhead.

NOTE: This routine uses ink to clean the printhead. Use the routine only to correct print quality errors. Do 
not use it for periodic maintenance. 

TIP: Turning the product off properly by pressing the power button on the front of the product helps keep 
the printhead from clogging and creating print-quality problems.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Printer Maintenance to view the list of cleaning and alignment routines.

4. Touch Clean Printhead Level 1, and then follow the prompts on the control panel. If necessary, load 
paper in the requested tray.

A page feeds through the product slowly. Discard the page when the process is completed.

5. If the printhead is still not clean, touch Clean Printhead Level 2, and follow the prompts on the control 
panel. If that does not work, continue with the next cleaning routine. Continue down the list of cleaning 
routines, if needed.

A page feeds through the product slowly. Discard the page when the process is completed.

Clean the touch screen
Clean the touch screen whenever it is necessary to remove fingerprints or dust. Wipe the touch screen gently 
with a clean, water-dampened, lint-free cloth.

NOTICE: Use water only. Solvents or cleaners can damage the touch screen. Do not pour or spray water 
directly onto the touch screen.
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Jams and paper-feed issues
Try these steps to solve paper-handling problems.

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the guides with 
the paper-size markings in the bottom of the tray.

4. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

5. Check the control panel to see if the product is waiting for you to acknowledge a prompt to feed the 
paper manually through Tray 1, the multipurpose tray on the left side of the product. Load paper, and 
continue.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package. 
Make sure all paper in the tray is the same type and size.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return less paper to the tray.

Even if the tray is not overfilled, try using a lower stack of media, such as half.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the guides with 
the paper-size markings in the bottom of the tray.

6. Print from another tray.

Prevent paper jams
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product. Lightweight, short-grain paper is not 
recommended.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.
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5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so 
they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use Tray 1, the multipurpose tray on the 
left side of the printer, and then feed sheets manually one at a time.

Clear jams
● Jam locations

● Clear jams in Tray 1 (multipurpose tray)

● Clear jams in Tray 2

● Clear jams in optional Tray 3

● Clear jams in optional Tray 4

● Clear jams in the left door

● Clear jams in the output bin

● Clear jams in the duplexer

NOTE: For best results, do not turn off the product before clearing paper jams.

Jam locations

Jams can occur in these locations:

1 Output bin

2 Tray 2

3 Tray 1

4 Left door

Traces of ink might remain in the product after a jam. This problem typically resolves itself after a few sheets 
have been printed.

Clear jams in Tray 1 (multipurpose tray)

▲ If the jammed sheet is visible and easily accessible in Tray 1, pull it from Tray 1.
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NOTE: If the sheet tears, make sure that all of the fragments are removed before you resume printing.

Clear jams in Tray 2

1. Open Tray 2 by pulling it out and releasing the latch at the rear left of the tray.

2. Remove the jammed sheet by pulling it to the right and then out of the product.
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3. Close Tray 2.

NOTE: To close the tray, push in the middle or with even pressure on both sides. Avoid pushing on one 
side only.

Clear jams in optional Tray 3

1. Open Tray 3.

2. Remove the jammed sheet by pulling it to the right and then out of the product.
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3. If the jam cannot be cleared at the tray, try clearing the jam from the Tray 3 left door.

4. Close Tray 3.

NOTE: To close the tray, push in the middle or with even pressure on both sides. Avoid pushing on one 
side only.

Clear jams in optional Tray 4

1. Open Tray 4.
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2. Remove the jammed sheet by pulling it to the right and then out of the product.

3. Close Tray 4.

NOTE: To close the tray, push in the middle or with even pressure on both sides. Avoid pushing on one 
side only.

Clear jams in the left door

1. Open the left door.
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2. Gently remove any visible paper from the rollers and delivery area.

NOTE: If the sheet tears, make sure that all fragments are removed before you resume printing. Do 
not use sharp objects to remove fragments.

3. Close the left door.

Clear jams in the output bin

1. Look for jammed paper in the output bin area.

2. Remove any visible media.

NOTE: If the sheet tears, remove all fragments before you resume printing.

3. Open and then close the left door to clear the message.

Clear jams in the duplexer

1. Open the left door.
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2. Remove the duplexer by pulling it out with both hands. Set the duplexer aside, upright, on a piece of 
paper to prevent spills.

NOTICE: When pulling out the duplexer, avoid making direct contact with the black cylinder to prevent 
ink smear on skin or clothes.

3. Lower the platen by pressing down on the green tab. This will cause the product to try to feed the sheet 
through the print zone. You may need to gently pull on the sheet if it does not feed. Remove the sheet.

4. Lift the green tab to place the platen back into its operating position.
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5. Reinstall the duplexer.

6. Close the left door.

Cartridge issues
Refilled or remanufactured cartridges

HP cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP 
products, HP cannot influence their design or control their quality. If you are using a refilled or 
remanufactured cartridge and are not satisfied with the print quality, replace the cartridge with a genuine HP 
cartridge.

NOTE: If you replace a non-HP cartridge with a genuine HP cartridge, the printhead may still contain non-
HP ink until the printhead is depleted of that ink and is supplied with ink from the newly installed, genuine HP 
cartridge. Until the non-HP ink is depleted, print quality will be affected.

Interpret control panel messages for cartridges

Cartridge Depleted

Description

The cartridge is at the end of its useful life, and the product will no longer print.

Recommended action

Depleted cartridges must be replaced to resume printing.

Cartridge Low

Description

The cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement cartridge on hand. You do not need to replace the 
cartridges until prompted to.
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Cartridge Very Low

Description

The cartridge is near the end of its useful life.

Recommended action

Have a replacement cartridge on hand. You do not need to replace the cartridges until prompted to.

Counterfeit or used [color] cartridge installed

Description

The original HP ink in this cartridge has been depleted.

Recommended action

Click OK to continue printing or replace with genuine HP cartridge.

Do not use SETUP cartridges

Description

SETUP cartridges cannot be used after the device has been initialized.

Recommended action

Remove and install non-SETUP cartridges.

Genuine HP cartridge installed

Description

A genuine HP cartridge was installed.

Recommended action

No action necessary.

Incompatible [color]

Description

You have installed a cartridge that is intended for use in a different HP product model. The product will NOT 
function with this print cartridge installed.

Recommended action

Install the correct cartridge for this product.

Incompatible cartridges

Description

● The contacts on the cartridge might not be making a connection to the printer.

● The cartridge is not compatible with your printer.

ENWW Cartridge issues 85



Recommended action

● Carefully clean the contacts on the cartridge by using a soft, lint-free cloth and insert the cartridge 
again.

● Remove this cartridge immediately and replace with a compatible cartridge.

Install [color] cartridge

Description

This message can appear during the initial set up of the product and may also appear after the initial set up of 
the product has been completed.

If this message appears during initial setup, it means one of the color cartridges is not installed with the door 
closed. The product will not print if a cartridge is missing.

If this message appears after the initial setup of the product, it means that the cartridge is missing or is 
installed but damaged.

Recommended action

Install or replace the indicated color cartridge.

Non-HP cartridges installed

Description

No action necessary, this is a notification only.

Recommended action

No action necessary, this is a notification only.

However, HP cannot recommend the use of non-HP supplies, either new or remanufactured. Touch OK to 
continue printing or replace the cartridge with a genuine HP cartridge.

Printer Failure

Description

The printer refuses to function.

Recommended action

Have a replacement cartridge on hand. You do not need to replace the cartridges until prompted to.

Problem with Print System

Description

The cartridge identified in the message is missing, damaged, incompatible, or inserted into the wrong slot in 
the printer.

Recommended action

Printing functionality is disabled. Visit the HP Customer Support website.
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Problem with Printer Preparation

Description

The printer clock has failed and cartridge preparation may not be complete. The estimated Cartridge Level 
gauge might be inaccurate.

Recommended action

Check the print quality of your print job. If it is not satisfactory, running the printhead cleaning procedure 
from the toolbox might improve it.

Problem with SETUP cartridges

Description

There is a problem with the SETUP cartridges and the printer cannot complete system initialization.

Recommended action

Visit the HP Customer Support website.

Use SETUP cartridges

Description

The SETUP cartridges have been removed before the product has completed initialization.

Recommended action

Use the SETUP cartridges that came with your product for product initialization.

When you first set up the printer, you must install the SETUP cartridges that shipped in the box with the 
printer. These cartridges calibrate your printer before the first print job. Failure to install the SETUP cartridges 
during the initial product setup causes an error. If you installed a set of regular cartridges, remove them and 
install the SETUP cartridges to complete printer setup. After printer setup is complete, the printer can use 
regular cartridges.

If you still receive error messages and the printer cannot complete system initialization, visit the HP Customer 
Support website.

Used [color] installed

Description

A used, but still genuine, HP color cartridge has been installed or moved.

Recommended action

You have a used, but still genuine, HP cartridge installed. No action required.

Printing issues
The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.
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● If the control panel does not indicate the product is ready, turn the product off and then on again.

● If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try to print a test page 
from the control panel. If the test page prints, there may be a communication problem between the 
product and the computer you are trying to print from.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the 
following items:

● Check the light next to the network connection on the product. If the network is active, the light is 
green.

● Make sure that you are using a network cable and not a phone cord to connect to the network.

● Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from 123.hp.com/pagewide (recommended) or from the HP software CD 
provided with the printer. Using generic printer drivers can cause delays clearing jobs from the print 
queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties , and 
open the Ports tab.

● If you are using a network cable to connect to the network, make sure the printer name listed on 
the Ports tab matches the product name on the product configuration page.

● If you are using a USB cable and are connecting to a wireless network, make sure the box is 
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication with 
the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference 
might be delaying print jobs.

The product prints slowly
If the product prints, but it seems slow, try the following solutions.

● Make sure the computer meets the minimum specifications for this product. For a list of specifications, 
visit HP Customer Support .

● If the paper type setting is not correct for the type of paper you are using, change the setting to the 
correct paper type.

● If your computer or the product is connected to a wireless network, low signal quality or interference 
might be delaying print jobs.

● If Quiet Mode is on, turn it off. This mode slows down the print speed. For more information, see Quiet 
Mode.

Plug-and-print USB issues
● The Memory Device Options menu does not open when you insert the USB accessory

● The file does not print from the USB storage device
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● The file that you want to print is not listed in the Memory Device Options menu

The Memory Device Options menu does not open when you insert the USB accessory

1. You might be using a USB storage device or a file system that this product does not support. Save the 
files on a standard USB storage device that uses File Allocation Table (FAT) file systems. The product 
supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage device.

3. The USB storage device might have multiple partitions. (Some USB storage device manufacturers install 
software on the accessory that creates partitions, similar to a CD.) Reformat the USB storage device to 
remove the partitions, or use a different USB storage device.

4. The USB storage device might require more power than the product can provide.

a. Remove the USB storage device.

b. Turn the product off and then on.

c. Use a USB storage device that has its own power supply or that requires less power.

5. The USB storage device might not be functioning correctly.

a. Remove the USB storage device.

b. Turn the product off and then on.

c. Try printing from another USB storage device.

The file does not print from the USB storage device

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.

The file that you want to print is not listed in the Memory Device Options menu

1. You might be trying to print a file type that the USB printing feature does not support. The product 
supports .DOC, .DOCX, .JPEG, .JPG, .PDF, PNG, .PPT, .PPTX, and .TIFF file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the number of 
files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case, the 
product replaces the file names with characters from a different character set. Rename the files using 
ASCII characters.

Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Check for genuine HP cartridges

● Use paper that meets HP specifications

● Use the correct paper type setting in the printer driver

● Use the printer driver that best meets your printing needs
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● Align the printhead

● Print a print-quality report

Check for genuine HP cartridges

Your cartridge may not be a genuine HP cartridge. For more information, see Counterfeit HP cartridges. 
Replace it with a genuine HP cartridge.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of ink are on the printed pages.

● Ink smears on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when 
selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, 
voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in PageWide printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using papers with 
the ColorLok® logo for this product. For details, visit the HP print permanence website.

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

● Ink smears on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Printed pages have small unprinted areas.

90 Chapter 7   Solve problems ENWW

http://www.hp.com/go/printpermanence


Change the paper type and size setting (Windows)

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click More.

5. Expand the list of Type Is options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click OK .

Change the paper type and size setting (OS X)

1. From the File menu, select Page Setup.

2. In Format For:, make sure your printer is selected.

3. From the Paper Size pop-up menu, select the correct size.

4. From the Copies & Pages pop-up menu, select Paper/Quality.

5. From the Media type: pop-up menu, select the correct media type.

Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics, missing 
text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed when installing the product 
from 123.hp.com/pagewide (recommended) or from the HP software CD provided with the 
printer.

● Recommended for all Windows environments. For Windows 7 and later, this driver is XPS-
based. For Windows 2003, XP, and Vista, a more basic PCL 6 print driver is provided.

● Provides the overall best speed, print quality, and product-feature support for most users.

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly graphics-
intensive software programs.

● Provides support for printing from postscript emulation needs, or for postscript flash font 
support.

● This driver is available for download at HP Universal Print Driver .

HP UPD PCL 6 ● Recommended for printing in all Windows environments.

● Provides the overall best speed, print quality, and printer feature support for users in managed 
environments.

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows 
environments.

● This driver is available for download at HP Universal Print Driver .

NOTE: Download additional printer drivers from the HP Customer Support website.
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Align the printhead

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Printer Maintenance, and then touch Align Printhead.

Print a print-quality report

Run a Print Quality report and follow the instructions. For more information, see Information pages.

Connectivity issues
Solve USB direct-connect problems

If you have connected the product directly to a computer, check the USB cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it with another product. Replace the cable if 
necessary.

Solve network problems
Check the following items to verify that the product is communicating with the network. Before beginning, 
print a configuration page from the control panel and locate the product IP address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct ethernet port using the proper cable.

2. Verify that cable connections are securely attached.

3. Look at the Ethernet port on the back of the product, and verify that the amber activity light and the 
green link-status light are active.

4. If the problem continues, try a different cable or port on the network router, switch, or hub.
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The computer is using the incorrect IP address for the product

1. On the computer, open the printer properties and click the Ports tab. Verify that the current IP address 
for the product is selected. The product IP address is listed on the product configuration page or through 
the control panel.

2. If you installed the product using an HP standard TCP/IP port, select the box labeled Always print to this 
printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP 
address.

If you installed the product from 123.hp.com/pagewide (recommended) or from the HP software CD 
provided with the printer, you can view or change the product IP address using the following steps:

a. Open the HP Printer Assistant. For more information, see Open the HP Printer Assistant.

b. Click the Tools tab.

c. Click Update IP Address to open a utility that reports the known (“previous”) IP address for the 
product and allows you to change the IP address, if necessary.

4. If the IP address is correct, delete the product entry from the list of installed printers, and then add it 
again.

The computer is unable to communicate with the product

1. Test network communication by pinging the product.

a. Open a command-line prompt on your computer. For Windows, click Start , click Run, and then 
type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, both the network and device are working.

2. If the ping command failed, verify that the network router, hubs, or switches are on, and then verify that 
the network settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

HP recommends leaving this setting in automatic mode (the default setting). If you change these settings, 
you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.
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The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.

Wireless network issues
Wireless connectivity checklist

● The product and the wireless router are turned on and have power. Also make sure the wireless radio in 
the product is turned on.

● The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you are 
not sure the SSID is correct, run the wireless setup again.

● With secured networks, make sure the security information is correct. If the security information is 
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network. If 
the network has Internet access, try connecting to the Internet over another wireless connection.

● The encryption method (AES or TKIP) is the same for the product as it is for the wireless access point, 
such as a wireless router (on networks using WPA security).

● The product is within the range of the wireless network. For most networks, the product must be within 
30 m (100 ft) of the wireless access point (wireless router).

● Obstacles do not block the wireless signal. Remove any large metal objects between the access point 
and the product. Make sure poles, walls, or support columns containing metal or concrete do not 
separate the product and wireless access point.

● The product is located away from electronic devices that might interfere with the wireless signal. Many 
devices can interfere with the wireless signal including motors, cordless phones, security system 
cameras, other wireless networks, and some Bluetooth devices.

● The printer driver is installed on the computer.

● You have selected the correct printer port.

● The computer and product connect to the same wireless network.

The product does not print, and the computer has a third-party firewall installed
1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you allow the 
programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the 
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product
Make sure that the router or product connects to the same network that your computer connects to.

94 Chapter 7   Solve problems ENWW



1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch .

3. Touch Reports , and then touch Network Configuration Page to print the report.

4. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer 
configuration for your computer.

5. If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure the 
wireless setup for your product.

Cannot connect more computers to the wireless product
1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. 

For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

a. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or 
touch the dashboard area on the home screen).

b. On the control panel dashboard, touch .

c. Touch Reports , and then touch Web Access Report to print the report.

5. Make sure that the correct port or product is selected.

● For printers installed without the fully featured installer:

a. From the list of printers on your computer, right-click the name of this product, click Printer 
Properties, and then open the Ports tab.

b. Make sure the box is checked next to Virtual printer port for USB.

● If you installed the printer software from 123.hp.com/pagewide (recommended) or from the HP 
software CD provided with the printer, you can view or change the product IP address using the 
following steps:

a. Click Start.

b. Click All Programs.

c. Click HP.

d. Click your product.

e. Click Update IP Address to open a utility that reports the known (“previous”) IP address for 
the product and allows you to change the IP address, if necessary.

6. Make sure that your computer is working correctly. If necessary, restart your computer.
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The wireless product loses communication when connected to a VPN
● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list
● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning
1. To verify if the network has lost communication, try connecting other devices to the network.

2. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start , click Run, and then 
type cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

c. If the window displays round-trip times, the network is working.

3. To make sure that the router or product connects to the same network that your computer connects to, 
print the Network Configuration Page. For instructions, see Information pages.

Product software issues (Windows)
Problem Solution

A printer driver for the 
product is not visible in the 
Printer folder

● Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the system tray, right-
click the icon, and select Close or Disable.

● Try plugging the USB cable into a different USB port on the computer.

An error message was 
displayed during the 
software installation

● Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the task bar, right-
click the icon, and select Close or Disable.

● Check the amount of free space on the drive where you are installing the product software. If necessary, free up 
as much space as you can, and reinstall the product software.

● If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready 
mode, but nothing prints

● Print a configuration page from the control panel, and verify the product functionality.

● Verify that all of the cables are correctly seated and within specifications. This includes the USB and power 
cables. Try a new cable.

● Verify the IP Address on the Configuration Page matches the IP address for the software port. Use one of the 
following procedures:

◦ Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista, installed without using 
the fully featured installer (such as Add Printer Wizard in Windows):

1. Click Start.

2. Click Settings.
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Problem Solution

3. Click Printers.

4. Right-click the product driver icon, and then select Properties .

5. Click the Ports tab, and then click Configure Port.

6. Verify the IP address, and then click OK or Cancel.

7. If the IP Addresses are not the same, delete the driver, and reinstall the driver using the correct IP 
address.

◦ Windows 7, installed without using the fully featured installer (such as Add Printer Wizard in Windows):

1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer properties.

4. Click the Ports tab, and then click Configure Port.

5. Verify the IP address, and then click OK or Cancel.

6. If the IP Addresses are not the same, delete the driver, and reinstall the driver using the correct IP 
address.

◦ Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista, and Windows 7, installed 
using the fully featured installer:

1. Click Start.

2. Click All Programs.

3. Click HP.

4. Click your product.

5. Click Update IP Address to open a utility that reports the known (“previous”) IP address for the 
product and allows you to change the IP address, if necessary.

Product software issues (OS X)
A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a configuration 
page to check the product name. Verify that the name on the configuration page matches the product 
name in the Printers list.

You are using a generic printer driver when using a USB connection
If you connected the USB cable before you installed the software, you might be using a generic printer driver 
instead of the driver for this product.
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1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software installation 
program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the Format For 
pop-up menu in the Print dialog box.
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8 Service and support

● Customer support

● HP limited warranty statement
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Customer support
If you need help from an HP technical support representative to solve a problem, contact HP Customer 
Support.

Register your product www.register.hp.com

Download software utilities, drivers, and electronic 
documentation

HP Customer Support

Get 24-hour Internet product support and troubleshooting and 
download drivers and software, and electronic information

HP Customer Support

Get support for products used with a Mac computer HP Customer Support  

Get telephone support, free during your warranty period, for your 
country/region

Have the product name, serial number, date of purchase, and 
problem description ready.

Country/region phone numbers are on the flyer that was in the 
box with your product or at HP Customer Support .

Order additional HP service or maintenance agreements www.hp.com/go/carepack
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HP limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP PageWide Pro 552dw 1 year

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in 
materials and workmanship after the date of purchase, for the period specified above. If HP receives notice of 
such defects during the warranty period, HP will, at its option, either repair or replace products which prove to 
be defective. Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of 
purchase, for the period specified above, due to defects in material and workmanship when properly installed 
and used. If HP receives notice of such defects during the warranty period, HP will replace software which 
does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, 
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a 
refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject 
to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b) 
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) 
operation outside of the published environmental specifications for the product, or (e) improper site 
preparation or maintenance.

HP’s limited warranty is void in the event the printer is attached to an aftermarket apparatus or system that 
modifies the printer’s functionality such as a continuous ink system.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER 
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY 
DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND 
FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or provinces do not allow limitations on 
the duration of an implied warranty, so the above limitation or exclusion might not apply to you. This 
warranty gives you specific legal rights and you might also have other rights that vary from country/region to 
country/region, state to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this 
product and where HP has marketed this product. The level of warranty service you receive may vary 
according to local standards. HP will not alter form, fit or function of the product to make it operate in a 
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE AND 
EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR 
LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR 
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or 
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO 
NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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UK, Ireland, and Malta
The HP Limited Warranty is a commercial guarantee voluntarily provided by HP. The name and address of the 
HP entity responsible for the performance of the HP Limited Warranty in your country/region is as follows:

UK: HP Inc UK Limited, Cain Road, Amen Corner, Bracknell, Berkshire, RG12 1HN

Ireland: Hewlett-Packard Ireland Limited, Liffey Park Technology Campus, Barnhall Road, Leixlip, Co.Kildare

Malta: Hewlett-Packard Europe B.V., Amsterdam, Meyrin Branch, Route du Nant-d'Avril 150, 1217 Meyrin, 
Switzerland

United Kingdom: The HP Limited Warranty benefits apply in addition to any legal rights to a guarantee from 
seller of nonconformity of goods with the contract of sale. These rights expire six years from delivery of 
goods for products purchased in England or Wales and five years from delivery of goods for products 
purchased in Scotland. However various factors may impact your eligibility to receive these rights. For further 
information, please consult the following link: Consumer Legal Guarantee (www.hp.com/go/eu-legal) or you 
may visit the European Consumer Centers website (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the right to 
choose whether to claim service under the HP Limited Warranty or against the seller under the legal 
guarantee.

Ireland: The HP Limited Warranty benefits apply in addition to any statutory rights from seller in relation to 
nonconformity of goods with the contract of sale. However various factors may impact your eligibility to 
receive these rights. Consumer statutory rights are not limited or affected in any manner by HP Care Pack. For 
further information, please consult the following link: Consumer Legal Guarantee (www.hp.com/go/eu-legal) 
or you may visit the European Consumer Centers website (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the right to 
choose whether to claim service under the HP Limited Warranty or against the seller under the legal 
guarantee.

Malta: The HP Limited Warranty benefits apply in addition to any legal rights to a two-year guarantee from 
seller of nonconformity of goods with the contract of sale; however various factors may impact your eligibility 
to receive these rights. Consumer statutory rights are not limited or affected in any manner by the HP Limited 
Warranty. For further information, please consult the following link: Consumer Legal Guarantee 
(www.hp.com/go/eu-legal) or you may visit the European Consumer Centers website (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the 
right to choose whether to claim service under the HP Limited Warranty or against the seller under two-year 
legal guarantee.

Austria, Belgium, Germany, and Luxemburg
Die beschränkte HP Herstellergarantie ist eine von HP auf freiwilliger Basis angebotene kommerzielle 
Garantie. Der Name und die Adresse der HP Gesellschaft, die in Ihrem Land für die Gewährung der 
beschränkten HP Herstellergarantie verantwortlich ist, sind wie folgt:

Deutschland: HP Deutschland GmbH, Schickardstr. 32, D-71034 Böblingen

Österreich: HP Austria GmbH., Technologiestrasse 5, A-1120 Wien

Luxemburg: Hewlett-Packard Luxembourg S.C.A., 75, Parc d'Activités Capellen, Rue Pafebruc, L-8308 Capellen

Belgien: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

Die Rechte aus der beschränkten HP Herstellergarantie gelten zusätzlich zu den gesetzlichen Ansprüchen 
wegen Sachmängeln auf eine zweijährige Gewährleistung ab dem Lieferdatum. Ob Sie Anspruch auf diese 
Rechte haben, hängt von zahlreichen Faktoren ab. Die Rechte des Kunden sind in keiner Weise durch die 
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beschränkte HP Herstellergarantie eingeschränkt bzw. betroffen. Weitere Hinweise finden Sie auf der 
folgenden Website: Gewährleistungsansprüche für Verbraucher (www.hp.com/go/eu-legal) oder Sie können 
die Website des Europäischen Verbraucherzentrums (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm) besuchen. Verbraucher haben das 
Recht zu wählen, ob sie eine Leistung von HP gemäß der beschränkten HP Herstellergarantie in Anspruch 
nehmen oder ob sie sich gemäß der gesetzlichen zweijährigen Haftung für Sachmängel (Gewährleistung) sich 
an den jeweiligen Verkäufer wenden.

Belgium, France, and Luxemburg
La garantie limitée HP est une garantie commerciale fournie volontairement par HP. Voici les coordonnées de 
l'entité HP responsable de l'exécution de la garantie limitée HP dans votre pays:

France: HP France SAS, société par actions simplifiée identifiée sous le numéro 448 694 133 RCS Evry, 1 
Avenue du Canada, 91947, Les Ulis

G.D. Luxembourg: Hewlett-Packard Luxembourg S.C.A., 75, Parc d'Activités Capellen, Rue Pafebruc, L-8308 
Capellen

Belgique: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

France: Les avantages de la garantie limitée HP s'appliquent en complément des droits dont vous disposez au 
titre des garanties légales applicables dont le bénéfice est soumis à des conditions spécifiques. Vos droits en 
tant que consommateur au titre de la garantie légale de conformité mentionnée aux articles L. 211-4 à L. 
211-13 du Code de la Consommation et de celle relatives aux défauts de la chose vendue, dans les conditions 
prévues aux articles 1641 à 1648 et 2232 du Code de Commerce ne sont en aucune façon limités ou affectés 
par la garantie limitée HP. Pour de plus amples informations, veuillez consulter le lien suivant : Garanties 
légales accordées au consommateur (www.hp.com/go/eu-legal). Vous pouvez également consulter le site 
Web des Centres européens des consommateurs (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Les consommateurs ont le droit de 
choisir d’exercer leurs droits au titre de la garantie limitée HP, ou auprès du vendeur au titre des garanties 
légales applicables mentionnées ci-dessus.

POUR RAPPEL:

Garantie Légale de Conformité:

« Le vendeur est tenu de livrer un bien conforme au contrat et répond des défauts de conformité existant lors 
de la délivrance.

Il répond également des défauts de conformité résultant de l'emballage, des instructions de montage ou de 
l'installation lorsque celle-ci a été mise à sa charge par le contrat ou a été réalisée sous sa responsabilité ».

Article L211-5 du Code de la Consommation:

« Pour être conforme au contrat, le bien doit:

1° Etre propre à l'usage habituellement attendu d'un bien semblable et, le cas échéant:

- correspondre à la description donnée par le vendeur et posséder les qualités que celui-ci a présentées à 
l'acheteur sous forme d'échantillon ou de modèle;

- présenter les qualités qu'un acheteur peut légitimement attendre eu égard aux déclarations publiques faites 
par le vendeur, par le producteur ou par son représentant, notamment dans la publicité ou l'étiquetage;

2° Ou présenter les caractéristiques définies d'un commun accord par les parties ou être propre à tout usage 
spécial recherché par l'acheteur, porté à la connaissance du vendeur et que ce dernier a accepté ».
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Article L211-12 du Code de la Consommation:

« L'action résultant du défaut de conformité se prescrit par deux ans à compter de la délivrance du bien ».

Garantie des vices cachés

Article 1641 du Code Civil : « Le vendeur est tenu de la garantie à raison des défauts cachés de la chose vendue 
qui la rendent impropre à l'usage auquel on la destine, ou qui diminuent tellement cet usage que l'acheteur ne 
l'aurait pas acquise, ou n'en aurait donné qu'un moindre prix, s'il les avait connus. »

Article 1648 alinéa 1 du Code Civil:

« L'action résultant des vices rédhibitoires doit être intentée par l'acquéreur dans un délai de deux ans à 
compter de la découverte du vice. »

G.D. Luxembourg et Belgique: Les avantages de la garantie limitée HP s'appliquent en complément des droits 
dont vous disposez au titre de la garantie de non-conformité des biens avec le contrat de vente. Cependant, 
de nombreux facteurs peuvent avoir un impact sur le bénéfice de ces droits. Vos droits en tant que 
consommateur au titre de ces garanties ne sont en aucune façon limités ou affectés par la garantie limitée 
HP. Pour de plus amples informations, veuillez consulter le lien suivant : Garanties légales accordées au 
consommateur (www.hp.com/go/eu-legal) ou vous pouvez également consulter le site Web des Centres 
européens des consommateurs (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Les consommateurs ont le droit de choisir de réclamer un service 
sous la garantie limitée HP ou auprès du vendeur au cours d'une garantie légale de deux ans.

Italy
La Garanzia limitata HP è una garanzia commerciale fornita volontariamente da HP. Di seguito sono indicati 
nome e indirizzo della società HP responsabile della fornitura dei servizi coperti dalla Garanzia limitata HP nel 
vostro Paese:

Italia: HP Italy S.r.l., Via G. Di Vittorio 9, 20063 Cernusco S/Naviglio

I vantaggi della Garanzia limitata HP vengono concessi ai consumatori in aggiunta ai diritti derivanti dalla 
garanzia di due anni fornita dal venditore in caso di non conformità dei beni rispetto al contratto di vendita. 
Tuttavia, diversi fattori possono avere un impatto sulla possibilita’ di beneficiare di tali diritti. I diritti spettanti 
ai consumatori in forza della garanzia legale non sono in alcun modo limitati, né modificati dalla Garanzia 
limitata HP. Per ulteriori informazioni, si prega di consultare il seguente link: Garanzia legale per i clienti 
(www.hp.com/go/eu-legal), oppure visitare il sito Web dei Centri europei per i consumatori 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). I 
consumatori hanno il diritto di scegliere se richiedere un servizio usufruendo della Garanzia limitata HP 
oppure rivolgendosi al venditore per far valere la garanzia legale di due anni.

Spain
Su Garantía limitada de HP es una garantía comercial voluntariamente proporcionada por HP. El nombre y 
dirección de las entidades HP que proporcionan la Garantía limitada de HP (garantía comercial adicional del 
fabricante) en su país es:

España: Hewlett-Packard Española S.L. Calle Vicente Aleixandre, 1 Parque Empresarial Madrid - Las Rozas, 
E-28232 Madrid

Los beneficios de la Garantía limitada de HP son adicionales a la garantía legal de 2 años a la que los 
consumidores tienen derecho a recibir del vendedor en virtud del contrato de compraventa; sin embargo, 
varios factores pueden afectar su derecho a recibir los beneficios bajo dicha garantía legal. A este respecto, la 
Garantía limitada de HP no limita o afecta en modo alguno los derechos legales del consumidor 
(www.hp.com/go/eu-legal). Para más información, consulte el siguiente enlace: Garantía legal del 
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consumidor o puede visitar el sitio web de los Centros europeos de los consumidores (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Los clientes tienen 
derecho a elegir si reclaman un servicio acogiéndose a la Garantía limitada de HP o al vendedor de 
conformidad con la garantía legal de dos años.

Denmark
Den begrænsede HP-garanti er en garanti, der ydes frivilligt af HP. Navn og adresse på det HP-selskab, der er 
ansvarligt for HP's begrænsede garanti i dit land, er som følger:

Danmark: HP Inc Danmark ApS, Engholm Parkvej 8, 3450, Allerød

Den begrænsede HP-garanti gælder i tillæg til eventuelle juridiske rettigheder, for en toårig garanti fra 
sælgeren af varer, der ikke er i overensstemmelse med salgsaftalen, men forskellige faktorer kan dog påvirke 
din ret til at opnå disse rettigheder. Forbrugerens lovbestemte rettigheder begrænses eller påvirkes ikke på 
nogen måde af den begrænsede HP-garanti. Se nedenstående link for at få yderligere oplysninger: 
Forbrugerens juridiske garanti (www.hp.com/go/eu-legal) eller du kan besøge De Europæiske 
Forbrugercentres websted (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Forbrugere har ret til at vælge, om de vil gøre krav på service i 
henhold til HP's begrænsede garanti eller hos sælger i henhold til en toårig juridisk garanti.

Norway
HPs garanti er en begrenset og kommersiell garanti som HP selv har valgt å tilby. Følgende lokale selskap 
innestår for garantien:

Norge: HP Norge AS, Rolfbuktveien 4b, 1364 Fornebu

HPs garanti kommer i tillegg til det mangelsansvar HP har i henhold til norsk forbrukerkjøpslovgivning, hvor 
reklamasjonsperioden kan være to eller fem år, avhengig av hvor lenge salgsgjenstanden var ment å vare. 
Ulike faktorer kan imidlertid ha betydning for om du kvalifiserer til å kreve avhjelp iht slikt mangelsansvar. 
Forbrukerens lovmessige rettigheter begrenses ikke av HPs garanti. Hvis du vil ha mer informasjon, kan du 
klikke på følgende kobling: Juridisk garanti for forbruker (www.hp.com/go/eu-legal) eller du kan besøke 
nettstedet til de europeiske forbrukersentrene (http://ec.europa.eu/consumers/solving_consumer_disputes/
non-judicial_redress/ecc-net/index_en.htm). Forbrukere har retten til å velge å kreve service under HPs 
garanti eller iht selgerens lovpålagte mangelsansvar.

Sweden
HP:s begränsade garanti är en kommersiell garanti som tillhandahålls frivilligt av HP. Namn och adress till det 
HP-företag som ansvarar för HP:s begränsade garanti i ditt land är som följer:

Sverige: HP PPS Sverige AB, SE-169 73 Stockholm

Fördelarna som ingår i HP:s begränsade garanti gäller utöver de lagstadgade rättigheterna till tre års garanti 
från säljaren angående varans bristande överensstämmelse gentemot köpeavtalet, men olika faktorer kan 
påverka din rätt att utnyttja dessa rättigheter. Konsumentens lagstadgade rättigheter varken begränsas eller 
påverkas på något sätt av HP:s begränsade garanti. Mer information får du om du följer denna länk: 
Lagstadgad garanti för konsumenter (www.hp.com/go/eu-legal) eller så kan du gå till European Consumer 
Centers webbplats (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-
net/index_en.htm). Konsumenter har rätt att välja om de vill ställa krav enligt HP:s begränsade garanti eller 
på säljaren enligt den lagstadgade treåriga garantin.
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Portugal
A Garantia Limitada HP é uma garantia comercial fornecida voluntariamente pela HP. O nome e a morada da 
entidade HP responsável pela prestação da Garantia Limitada HP no seu país são os seguintes:

Portugal: HPCP – Computing and Printing Portugal, Unipessoal, Lda., Edificio D. Sancho I, Quinta da Fonte, 
Porto Salvo, Lisboa, Oeiras, 2740 244

As vantagens da Garantia Limitada HP aplicam-se cumulativamente com quaisquer direitos decorrentes da 
legislação aplicável à garantia de dois anos do vendedor, relativa a defeitos do produto e constante do 
contrato de venda. Existem, contudo, vários fatores que poderão afetar a sua elegibilidade para beneficiar de 
tais direitos. Os direitos legalmente atribuídos aos consumidores não são limitados ou afetados de forma 
alguma pela Garantia Limitada HP. Para mais informações, consulte a ligação seguinte: Garantia legal do 
consumidor (www.hp.com/go/eu-legal) ou visite o Web site da Rede dos Centros Europeus do Consumidor 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). 
Os consumidores têm o direito de escolher se pretendem reclamar assistência ao abrigo da Garantia Limitada 
HP ou contra o vendedor ao abrigo de uma garantia jurídica de dois anos.

Greece and Cyprus
Η Περιορισμένη εγγύηση HP είναι μια εμπορική εγγύηση η οποία παρέχεται εθελοντικά από την HP. Η 
επωνυμία και η διεύθυνση του νομικού προσώπου ΗΡ που παρέχει την Περιορισμένη εγγύηση ΗΡ στη χώρα 
σας είναι η εξής:

Ελλάδα /Κύπρoς: HP Printing and Personal Systems Hellas EPE, Tzavella 1-3, 15232 Chalandri, Attiki

Ελλάδα /Κύπρoς: HP Συστήματα Εκτύπωσης και Προσωπικών Υπολογιστών Ελλάς Εταιρεία Περιορισμένης 
Ευθύνης, Tzavella 1-3, 15232 Chalandri, Attiki

Τα προνόμια της Περιορισμένης εγγύησης HP ισχύουν επιπλέον των νόμιμων δικαιωμάτων για διετή εγγύηση 
έναντι του Πωλητή για τη μη συμμόρφωση των προϊόντων με τις συνομολογημένες συμβατικά ιδιότητες, 
ωστόσο η άσκηση των δικαιωμάτων σας αυτών μπορεί να εξαρτάται από διάφορους παράγοντες. Τα νόμιμα 
δικαιώματα των καταναλωτών δεν περιορίζονται ούτε επηρεάζονται καθ’ οιονδήποτε τρόπο από την 
Περιορισμένη εγγύηση HP. Για περισσότερες πληροφορίες, συμβουλευτείτε την ακόλουθη τοποθεσία web: 
Νόμιμη εγγύηση καταναλωτή (www.hp.com/go/eu-legal) ή μπορείτε να επισκεφτείτε την τοποθεσία web των 
Ευρωπαϊκών Κέντρων Καταναλωτή (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Οι καταναλωτές έχουν το δικαίωμα να επιλέξουν αν θα αξιώσουν 
την υπηρεσία στα πλαίσια της Περιορισμένης εγγύησης ΗΡ ή από τον πωλητή στα πλαίσια της νόμιμης 
εγγύησης δύο ετών.

Hungary
A HP korlátozott jótállás egy olyan kereskedelmi jótállás, amelyet a HP a saját elhatározásából biztosít. Az 
egyes országokban a HP mint gyártó által vállalt korlátozott jótállást biztosító HP vállalatok neve és címe:

Magyarország: HP Inc Magyarország Kft., H-1117 Budapest, Alíz utca 1.

A HP korlátozott jótállásban biztosított jogok azokon a jogokon felül illetik meg Önt, amelyek a termékeknek 
az adásvételi szerződés szerinti minőségére vonatkozó kétéves, jogszabályban foglalt eladói szavatosságból, 
továbbá ha az Ön által vásárolt termékre alkalmazandó, a jogszabályban foglalt kötelező eladói jótállásból 
erednek, azonban számos körülmény hatással lehet arra, hogy ezek a jogok Önt megilletik-e. További 
információért kérjük, keresse fel a következő webhelyet: Jogi Tájékoztató Fogyasztóknak 
(www.hp.com/go/eu-legal) vagy látogassa meg az Európai Fogyasztói Központok webhelyét 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). A 
fogyasztóknak jogában áll, hogy megválasszák, hogy a jótállással kapcsolatos igényüket a HP korlátozott 
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jótállás alapján vagy a kétéves, jogszabályban foglalt eladói szavatosság, illetve, ha alkalmazandó, a 
jogszabályban foglalt kötelező eladói jótállás alapján érvényesítik.

Czech Republic
Omezená záruka HP je obchodní zárukou dobrovolně poskytovanou společností HP. Názvy a adresy 
společností skupiny HP, které odpovídají za plnění omezené záruky HP ve vaší zemi, jsou následující:

Česká republika: HP Inc Czech Republic s. r. o., Za Brumlovkou 5/1559, 140 00 Praha 4

Výhody, poskytované omezenou zárukou HP, se uplatňuji jako doplňek k jakýmkoli právním nárokům na 
dvouletou záruku poskytnutou prodejcem v případě nesouladu zboží s kupní smlouvou. Váš nárok na uznání 
těchto práv však může záviset na mnohých faktorech. Omezená záruka HP žádným způsobem neomezuje ani 
neovlivňuje zákonná práva zákazníka. Další informace získáte kliknutím na následující odkaz: Zákonná záruka 
spotřebitele (www.hp.com/go/eu-legal) případně můžete navštívit webové stránky Evropského 
spotřebitelského centra (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/
ecc-net/index_en.htm). Spotřebitelé mají právo se rozhodnout, zda chtějí službu reklamovat v rámci omezené 
záruky HP nebo v rámci zákonem stanovené dvouleté záruky u prodejce.

Slovakia
Obmedzená záruka HP je obchodná záruka, ktorú spoločnosť HP poskytuje dobrovoľne. Meno a adresa 
subjektu HP, ktorý zabezpečuje plnenie vyplývajúce z Obmedzenej záruky HP vo vašej krajine:

Slovenská republika: HP Inc Slovakia, s.r.o., Galvaniho 7, 821 04 Bratislava

Výhody Obmedzenej záruky HP sa uplatnia vedľa prípadných zákazníkových zákonných nárokov voči 
predávajúcemu z vád, ktoré spočívajú v nesúlade vlastností tovaru s jeho popisom podľa predmetnej zmluvy. 
Možnosť uplatnenia takých prípadných nárokov však môže závisieť od rôznych faktorov. Služby Obmedzenej 
záruky HP žiadnym spôsobom neobmedzujú ani neovplyvňujú zákonné práva zákazníka, ktorý je 
spotrebiteľom. Ďalšie informácie nájdete na nasledujúcom prepojení: Zákonná záruka spotrebiteľa 
(www.hp.com/go/eu-legal), prípadne môžete navštíviť webovú lokalitu európskych zákazníckych stredísk 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). 
Spotrebitelia majú právo zvoliť si, či chcú uplatniť servis v rámci Obmedzenej záruky HP alebo počas zákonnej 
dvojročnej záručnej lehoty u predajcu.

Poland
Ograniczona gwarancja HP to komercyjna gwarancja udzielona dobrowolnie przez HP. Nazwa i adres 
podmiotu HP odpowiedzialnego za realizację Ograniczonej gwarancji HP w Polsce:

Polska: HP Inc Polska sp. z o.o., Szturmowa 2a, 02-678 Warszawa, wpisana do rejestru przedsiębiorców 
prowadzonego przez Sąd Rejonowy dla m.st. Warszawy w Warszawie, XIII Wydział Gospodarczy Krajowego 
Rejestru Sądowego, pod numerem KRS 0000546115, NIP 5213690563, REGON 360916326, GIOŚ 
E0020757WZBW, kapitał zakładowy 480.000 PLN.

Świadczenia wynikające z Ograniczonej gwarancji HP stanowią dodatek do praw przysługujących nabywcy w 
związku z dwuletnią odpowiedzialnością sprzedawcy z tytułu niezgodności towaru z umową (rękojmia). 
Niemniej, na możliwość korzystania z tych praw mają wpływ różne czynniki. Ograniczona gwarancja HP w 
żaden sposób nie ogranicza praw konsumenta ani na nie nie wpływa. Więcej informacji można znaleźć pod 
następującym łączem: Gwarancja prawna konsumenta (www.hp.com/go/eu-legal), można także odwiedzić 
stronę internetową Europejskiego Centrum Konsumenckiego (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Konsumenci mają prawo wyboru co 
do możliwosci skorzystania albo z usług gwarancyjnych przysługujących w ramach Ograniczonej gwarancji HP 
albo z uprawnień wynikających z dwuletniej rękojmi w stosunku do sprzedawcy.
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Bulgaria
Ограничената гаранция на HP представлява търговска гаранция, доброволно предоставяна от HP. 
Името и адресът на дружеството на HP за вашата страна, отговорно за предоставянето на 
гаранционната поддръжка в рамките на Ограничената гаранция на HP, са както следва:

HP Inc Bulgaria EOOD (Ейч Пи Инк България ЕООД), гр. София 1766, район р-н Младост, бул. 
Околовръстен Път No 258, Бизнес Център Камбаните

Предимствата на Ограничената гаранция на HP се прилагат в допълнение към всички законови права за 
двугодишна гаранция от продавача при несъответствие на стоката с договора за продажба. Въпреки 
това, различни фактори могат да окажат влияние върху условията за получаване на тези права. 
Законовите права на потребителите не са ограничени или засегнати по никакъв начин от Ограничената 
гаранция на HP. За допълнителна информация, моля вижте Правната гаранция на потребителя 
(www.hp.com/go/eu-legal) или посетете уебсайта на Европейския потребителски център 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). 
Потребителите имат правото да избират дали да претендират за извършване на услуга в рамките на 
Ограничената гаранция на HP или да потърсят такава от търговеца в рамките на двугодишната правна 
гаранция.

Romania
Garanția limitată HP este o garanție comercială furnizată în mod voluntar de către HP. Numele și adresa 
entității HP răspunzătoare de punerea în aplicare a Garanției limitate HP în țara dumneavoastră sunt 
următoarele:

Romănia: HP Inc Romania SRL, 5 Fabrica de Glucoza Str., Building F, Ground Floor & Floor 8, 2nd District, 
Bucureşti

Beneficiile Garanției limitate HP se aplică suplimentar faţă de orice drepturi privind garanţia de doi ani oferită 
de vânzător pentru neconformitatea bunurilor cu contractul de vânzare; cu toate acestea, diverşi factori pot 
avea impact asupra eligibilităţii dvs. de a beneficia de aceste drepturi. Drepturile legale ale consumatorului nu 
sunt limitate sau afectate în vreun fel de Garanția limitată HP. Pentru informaţii suplimentare consultaţi 
următorul link: garanția acordată consumatorului prin lege (www.hp.com/go/eu-legal) sau puteți accesa site-
ul Centrul European al Consumatorilor (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Consumatorii au dreptul să aleagă dacă să pretindă despăgubiri în 
cadrul Garanței limitate HP sau de la vânzător, în cadrul garanției legale de doi ani.

Belgium and the Netherlands
De Beperkte Garantie van HP is een commerciële garantie vrijwillig verstrekt door HP. De naam en het adres 
van de HP-entiteit die verantwoordelijk is voor het uitvoeren van de Beperkte Garantie van HP in uw land is 
als volgt:

Nederland: HP Nederland B.V., Startbaan 16, 1187 XR Amstelveen

België: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

De voordelen van de Beperkte Garantie van HP vormen een aanvulling op de wettelijke garantie voor 
consumenten gedurende twee jaren na de levering te verlenen door de verkoper bij een gebrek aan 
conformiteit van de goederen met de relevante verkoopsovereenkomst. Niettemin kunnen diverse factoren 
een impact hebben op uw eventuele aanspraak op deze wettelijke rechten. De wettelijke rechten van de 
consument worden op geen enkele wijze beperkt of beïnvloed door de Beperkte Garantie van HP. Raadpleeg 
voor meer informatie de volgende webpagina: Wettelijke garantie van de consument (www.hp.com/go/eu-
legal) of u kan de website van het Europees Consumenten Centrum bezoeken (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumenten hebben 
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het recht om te kiezen tussen enerzijds de Beperkte Garantie van HP of anderzijds het aanspreken van de 
verkoper in toepassing van de wettelijke garantie.

Finland
HP:n rajoitettu takuu on HP:n vapaaehtoisesti antama kaupallinen takuu. HP:n myöntämästä takuusta 
maassanne vastaavan HP:n edustajan yhteystiedot ovat:

Suomi: HP Finland Oy, Piispankalliontie, FIN - 02200 Espoo

HP:n takuun edut ovat voimassa mahdollisten kuluttajansuojalakiin perustuvien oikeuksien lisäksi sen 
varalta, että tuote ei vastaa myyntisopimusta. Saat lisätietoja seuraavasta linkistä: Kuluttajansuoja 
(www.hp.com/go/eu-legal) tai voit käydä Euroopan kuluttajakeskuksen sivustolla (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Kuluttajilla on oikeus 
vaatia virheen korjausta HP:n takuun ja kuluttajansuojan perusteella HP:lta tai myyjältä.

Slovenia
Omejena garancija HP je prostovoljna trgovska garancija, ki jo zagotavlja podjetje HP. Ime in naslov poslovne 
enote HP, ki je odgovorna za omejeno garancijo HP v vaši državi, sta naslednja:

Slovenija: Hewlett-Packard Europe B.V., Amsterdam, Meyrin Branch, Route du Nant-d'Avril 150, 1217 Meyrin, 
Switzerland

Ugodnosti omejene garancije HP veljajo poleg zakonskih pravic, ki ob sklenitvi kupoprodajne pogodbe izhajajo 
iz dveletne garancije prodajalca v primeru neskladnosti blaga, vendar lahko na izpolnjevanje pogojev za 
uveljavitev pravic vplivajo različni dejavniki. Omejena garancija HP nikakor ne omejuje strankinih z zakonom 
predpisanih pravic in ne vpliva nanje. Za dodatne informacije glejte naslednjo povezavo: Strankino pravno 
jamstvo (www.hp.com/go/eu-legal); ali pa obiščite spletno mesto evropskih središč za potrošnike 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). 
Potrošniki imajo pravico izbrati, ali bodo uveljavljali pravice do storitev v skladu z omejeno garancijo HP ali 
proti prodajalcu v skladu z dvoletno zakonsko garancijo.

Croatia
HP ograničeno jamstvo komercijalno je dobrovoljno jamstvo koje pruža HP. Ime i adresa HP subjekta 
odgovornog za HP ograničeno jamstvo u vašoj državi:

Hrvatska: HP Computing and Printing d.o.o. za računalne i srodne aktivnosti, Radnička cesta 41, 10000 
Zagreb

Pogodnosti HP ograničenog jamstva vrijede zajedno uz sva zakonska prava na dvogodišnje jamstvo kod bilo 
kojeg prodavača s obzirom na nepodudaranje robe s ugovorom o kupnji. Međutim, razni faktori mogu utjecati 
na vašu mogućnost ostvarivanja tih prava. HP ograničeno jamstvo ni na koji način ne utječe niti ne ograničava 
zakonska prava potrošača. Dodatne informacije potražite na ovoj adresi: Zakonsko jamstvo za potrošače 
(www.hp.com/go/eu-legal) ili možete posjetiti web-mjesto Europskih potrošačkih centara 
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). 
Potrošači imaju pravo odabrati žele li ostvariti svoja potraživanja u sklopu HP ograničenog jamstva ili pravnog 
jamstva prodavača u trajanju ispod dvije godine.

Latvia
HP ierobežotā garantija ir komercgarantija, kuru brīvprātīgi nodrošina HP. HP uzņēmums, kas sniedz HP 
ierobežotās garantijas servisa nodrošinājumu jūsu valstī:

Latvija: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

ENWW HP limited warranty statement 109

http://www.hp.com/go/eu-legal
http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm
http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm
http://www.hp.com/go/eu-legal
http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm
http://www.hp.com/go/eu-legal
http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm


HP ierobežotās garantijas priekšrocības tiek piedāvātas papildus jebkurām likumīgajām tiesībām uz 
pārdevēja un/vai rażotāju nodrošinātu divu gadu garantiju gadījumā, ja preces neatbilst pirkuma līgumam, 
tomēr šo tiesību saņemšanu var ietekmēt vairāki faktori. HP ierobežotā garantija nekādā veidā neierobežo un 
neietekmē patērētāju likumīgās tiesības. Lai iegūtu plašāku informāciju, izmantojiet šo saiti: Patērētāju 
likumīgā garantija (www.hp.com/go/eu-legal) vai arī Eiropas Patērētāju tiesību aizsardzības centra tīmekļa 
vietni (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/
index_en.htm). Patērētājiem ir tiesības izvēlēties, vai pieprasīt servisa nodrošinājumu saskaņā ar HP 
ierobežoto garantiju, vai arī pārdevēja sniegto divu gadu garantiju.

Lithuania
HP ribotoji garantija yra HP savanoriškai teikiama komercinė garantija. Toliau pateikiami HP bendrovių, 
teikiančių HP garantiją (gamintojo garantiją) jūsų šalyje, pavadinimai ir adresai:

Lietuva: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP ribotoji garantija papildomai taikoma kartu su bet kokiomis kitomis įstatymais nustatytomis teisėmis į 
pardavėjo suteikiamą dviejų metų laikotarpio garantiją dėl prekių atitikties pardavimo sutarčiai, tačiau tai, ar 
jums ši teisė bus suteikiama, gali priklausyti nuo įvairių aplinkybių. HP ribotoji garantija niekaip neapriboja ir 
neįtakoja įstatymais nustatytų vartotojo teisių. Daugiau informacijos rasite paspaudę šią nuorodą: Teisinė 
vartotojo garantija (www.hp.com/go/eu-legal) arba apsilankę Europos vartotojų centro internetinėje 
svetainėje (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/
index_en.htm). Vartotojai turi teisę prašyti atlikti techninį aptarnavimą pagal HP ribotąją garantiją arba 
pardavėjo teikiamą dviejų metų įstatymais nustatytą garantiją.

Estonia
HP piiratud garantii on HP poolt vabatahtlikult pakutav kaubanduslik garantii. HP piiratud garantii eest 
vastutab HP üksus aadressil:

Eesti: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP piiratud garantii rakendub lisaks seaduses ettenähtud müüjapoolsele kaheaastasele garantiile, juhul kui 
toode ei vasta müügilepingu tingimustele. Siiski võib esineda asjaolusid, mille puhul teie jaoks need õigused 
ei pruugi kehtida. HP piiratud garantii ei piira ega mõjuta mingil moel tarbija seadusjärgseid õigusi. Lisateavet 
leiate järgmiselt lingilt: tarbija õiguslik garantii (www.hp.com/go/eu-legal) või võite külastada Euroopa 
tarbijakeskuste veebisaiti (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/
ecc-net/index_en.htm). Tarbijal on õigus valida, kas ta soovib kasutada HP piiratud garantiid või seadusega 
ette nähtud müüjapoolset kaheaastast garantiid.

Russia
Срок службы принтера для России

Срок службы данного принтера HP составляет пять лет в нормальных условиях эксплуатации. Срок 
службы отсчитывается с момента ввода принтера в эксплуатацию. В конце срока службы HP 
рекомендует посетить веб-сайт нашей службы поддержки по адресу http://www.hp.com/support и/или 
связаться с авторизованным поставщиком услуг HP для получения рекомендаций в отношении 
дальнейшего безопасного использования принтера.
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Product specifications
● Print specifications

● Physical specifications

● Power consumption and electrical specifications

● Acoustic emission specifications

● Environmental specifications

Print specifications
For a list of supported print resolutions, visit the printer support website at HP Customer Support .

Physical specifications

Product Product dimensions (width x 
depth x height)

Operation dimensions (width x 
depth x height)

Weight

HP PageWide Pro 552dw series 530 x 407 x 468 mm (20.87 x 
16.02 x 18.43 inches)

806 x 731 x 712 mm (31.73 x 
28.78 x 28.03 inches)

16.4 kg (35.1 lb)

Power consumption and electrical specifications

CAUTION: Power requirements are based on the country/region where the product is sold. Do not convert 
operating voltages. This will damage the product and any such damage is not covered under the HP limited 
warranty and service agreements.

Acoustic emission specifications

Operation LwAd-mono (B) LwAd-color (B)

Print 6.9 6.8

NOTE: HP recommends that the printer be located in a room in which no employee has a regular 
workstation.

Environmental specifications

 Operating Transporting

Temperature 15° to 30° C

(59° to 86° F)

–40° to 60° C

(–40° to 140° F)

Relative humidity 20 to 80% 90% or less (non-condensing)
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 Operating Transporting

Altitude 0 to 3048 m (0 to 10,000 ft)  

Tilt IMPORTANT: Use caution when moving the 
product after you install the cartridges. Tilting 
the product at an angle greater than 3 degrees 
can result in ink leakage.

 

NOTE: Values are subject to change.
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Environmental product stewardship program
● Protecting the environment

● Ozone production

● Power consumption

● European Union Commission Regulation 1275/2008

● Paper

● HP PageWide printing supplies

● Plastics

● Electronic hardware recycling 

● Material restrictions

— General battery information

— Battery disposal in Taiwan

— California Perchlorate Material Notice

— EU Battery Directive

— Battery notice for Brazil

● Chemical substances

● EPEAT

● Disposal of waste equipment by users

● Toxic and hazardous substance table (China)

● Restriction on hazardous substances statement (Turkey)

● Restriction on hazardous substances statement (Ukraine)

● Restriction of hazardous substance statement (India)

● China energy label for printer, fax, and copier

● China SEPA Eco Label user information
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Protecting the environment
HP is committed to providing quality products in an environmentally sound manner. This product has been 
designed with several attributes to minimize impacts on our environment.

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment to obtain more 
information about HP and the environment, including environmental profile sheets for these products, 
Material Data Safety Sheets, and HP return and recycling programs.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. 
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging 
products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar

European Union Commission Regulation 1275/2008
For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P14 
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Paper
This product is capable of using recycled paper and lightweight paper (EcoFFICIENT™) when the paper meets 
the guidelines outlined in the product’s Print Media Guide. This product is suitable for the use of recycled 
paper and lightweight paper (EcoFFICIENT™) according to EN12281:2002.

HP PageWide printing supplies
Original HP Supplies were designed with the environment in mind. HP makes it easy to conserve resources 
and paper when printing. And when you are done, we make it easy and free to recycle. Program availability 
varies. For more information, visit www.hp.com/recycle. To participate in HP Planet Partners return and 
recycling program, visit www.hp.com/recycle. Select your country/region for information on how to return 
your HP PageWide printing supplies.

NOTE: Visit the HP sustainability website for complete recycling information and to order postage-paid 
labels, envelopes, or boxes, for recycling.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of the product’s life.
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Electronic hardware recycling
HP encourages customers to recycle used electronic hardware. For more information about recycling 
programs, visit the HP sustainability website.

Material restrictions
● General battery information

● Battery disposal in Taiwan

● California Perchlorate Material Notice

● EU Battery Directive

● Battery notice for Brazil

General battery information

This HP product does not contain intentionally added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries contained 
in or supplied by HP for this product include the following.

HP PageWide Pro 552dw series

Type Lithium Manganese Dioxide

Weight 3.0 g

Location On main board

User-removable No

Battery disposal in Taiwan

California Perchlorate Material Notice

EU Battery Directive

This product contains a battery that is used to maintain data integrity of real time clock or product settings 
and is designed to last the life of the product.  Any attempt to service or replace this battery should be 
performed by a qualified service technician.
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Battery notice for Brazil

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at 
http://www.hp.com/go/reach.

EPEAT
Most HP products are designed to meet EPEAT. EPEAT is a comprehensive environmental rating that helps 
identify greener electronics equipment. For more information on EPEAT go to www.epeat.net. For information 
on HP's EPEAT registered products go to www.hp.com/hpinfo/globalcitizenship/environment/pdf/
epeat_printers.pdf.

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, you should 
protect human health and the environment by handing over your waste equipment to a designated collection 
point for the recycling of waste electrical and electronic equipment. For more information, go to http://
www.hp.com/recycle
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Toxic and hazardous substance table (China)

Restriction on hazardous substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur

Restriction on hazardous substances statement (Ukraine)
Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких 
небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою 
Кабінету Міністрів України від 3 грудня 2008 № 1057

Restriction of hazardous substance statement (India)
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China energy label for printer, fax, and copier

China SEPA Eco Label user information
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Regulatory information
● Regulatory notices

● VCCI statement (Japan)

● Power cord instructions

● Power cord statement (Japan)

● EMC statement (Korea)

● Visual display workplaces statement for Germany

● European Union Regulatory Notice

● Additional statements for wireless products

Regulatory notices

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. This regulatory 
number should not be confused with the marketing name or product numbers.

Table A-1  Regulatory model numbers

Product model number Regulatory Model Number

PageWide Pro 552dw VCVRA-1503–00

PageWide Pro 552dw VCVRA-1503–01

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase the separation between the equipment and receiver.

● Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

● Consult the dealer or an experienced radio/TV technician for help.

NOTE: Any changes or modifications made to this device that are not expressly approved by HP may void 
the user's authority to operate the equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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For further information, contact: Manager of Corporate Product Regulations, HP Inc., 1501 Page Mill Road, 
Palo Alto, CA 94304, USA.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.

VCCI statement (Japan)

Power cord instructions
Make sure your power source is adequate for the product voltage rating. The voltage rating is on the product 
label. The product uses either 100-240 Vac or 200-240 Vac and 50/60 Hz.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the product.

Power cord statement (Japan)

EMC statement (Korea)

Visual display workplaces statement for Germany
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European Union Regulatory Notice
● European Union Regulatory Notice

● Wireless models only 

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be 
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, 
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using 
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following 
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number 
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

HP GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

Wireless models only

EMF

● This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.

If it incorporates a radio transmitting and receiving device that in normal use, a separation distance of 
20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

● This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein, 
Norway and Switzerland.
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Additional statements for wireless products
● Exposure to radio frequency radiation

● Notice to users in Brazil

● Canadian statements

● Japan statement

● Notice to users in Korea

● Taiwan statement

● Mexico statement

Exposure to radio frequency radiation

Notice to users in Brazil

Canadian statements

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and 
maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio 
interference to other users, the antenna type and its gain should be so chosen that the equivalent 
isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device.

WARNING! Exposure to Radio Frequency Radiation The radiated output power of this device is below the 
Industry Canada radio frequency exposure limits. Nevertheless, the device should be used in such a manner 
that the potential for human contact is minimized during normal operation.

To avoid the possibility of exceeding the Industry Canada radio frequency exposure limits, human proximity 
to the antennas should not be less than 20 cm (8 inches).
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Japan statement

Notice to users in Korea

Taiwan statement

Mexico statement

Aviso para los usuarios de México

La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este equipo o 
dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier 
interferencia, incluyendo la que pueda causar su operación no deseada. Para saber el modelo de la tarjeta 
inalámbrica utilizada, revise la etiqueta regulatoria de la impresora.
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